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Welcome

Welcome

The TekExpress DisplayPort 2.0 software supports specification 2.0 and performs the pre-compliance tests. It uses DPOJET (Jitter and
Eye Analysis tool), ClO plug-in, SDLA (Serial Data Link Layer Analysis), and DisplayPort Essential (DisplayPort measurement library) to
perform the pre-compliance tests. These tools are offered by Tektronix for characterization/debug tests and compliance tests of the silicon.
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Figure 1: Setup panel with compliance view
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Figure 2: Setup panel with advanced view
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Key features

Complete pre-compliance testing of data rates UHBR10, UHBR13.5, and UHBR20 for DP2.0 Source devices (Standard and Type-C
connectors)

Supports PO to P15 presets for signal test

Supports both TP2 and TP3 EQ test point testing. Use SDLA for TP3 EQ test point analysis.

Optimized algorithms to execute tests with improved accuracy

Supports measurements that are not supported in CTS (SSC measurements, Unit Interval Measurements, LFUDJ Measurements)
Support P7625 and P7633 differential probes

Fixture De-embedding in differential and single-ended mode by creating a custom filter file using SDLA software to leverage the
channel modeling and receiver equalization functionality.

Selective testing:

+  Selection of specific or all data rates.

+  Selection of tests individually or in groups.

+  Selection of specific presets for individual measurements.
+  Selection of SSC On, Off, or Both.

Quick testing:

+  Support for using saved setup for testing. Avoids overhead of doing the setup for every run.
+  Support multi-lane testing on one go.

+ Analyze multiple data rates and multiple presets on one go.

+ Analyze TP2 and TP3 EQ test points on one go.

+  One-click selection of multiple tests ensures faster testing.

+ One-click report format change

Avoids repeated testing through accurate and reliable results from a single run
Supports multi-run feature for test repetition with the same setup

Supports signal validation option to detect anomalies in the signal before analysis
Supports offline analysis of the saved waveforms in Pre-Recorded mode

Detailed test reporting:

+  Exports available in .mht, .pdf and .csv formats for advanced data analysis

+ Provides a Pass/Fail summary table

+  Provides pre-compliance report

+  Provides limits and margin details on each test

+ Provides all results, grouped by features

+ Provides a consolidated report for all tests

DisplayPort 2.0 DPOJET plug-in solution provides the MOI and setup files for debugging and characterization.

TekExpress® DisplayPort 2.0 Automated Solution 9



Getting help and support

Getting help and support

Product documents

Use the product documents for more information on the application functions, understand the theory of operation, how to remotely program
or operate the application, and do other tasks.

Table 1: TekExpress Application documents

To learn about Use this document
How to use the application TekExpress <Application Name> Help
How to remotely control the instrument PDF version of this document can be downloaded from www.tek.com/downloads

Compiled HTML (CHM) version is integrated with the application. Press F1 key from the
keyboard to start the help.

Tektronix Part Number; 077-xXxX-Xx

Conventions

This application help uses the following conventions:

+ The term "Application," and "Software" refers to the TekExpress Application.
+ The term “DUT" is an abbreviation for Device Under Test.

+ The term “select” is a generic term that applies to the two methods of choosing a screen item (button control, list item): using a mouse
or using the touch screen.

+ A Note identifies important information.

Table 2: Icons used in the help

Icon Description

oy This icon identifies important information

f This icon identifies conditions or practices that could result in loss of data.
=

This icon identifies additional information that will help you use the application more
efficiently.

TekExpress® DisplayPort 2.0 Automated Solution 10
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Getting help and support

Technical support

Tektronix values your feedback on our products. To help us serve you better, please send us your suggestions, ideas, or comments on
your application or oscilloscope. Contact Tektronix through mail, telephone, or the Web site. See Contacting Tektronix at the front of this
document for contact information.

When you contact Tektronix Technical Support, please include the following information (be as specific as possible):
General information

+  All instrument model numbers

+ Hardware options, if any

+  Modules used

* Your name, company, mailing address, phone number, FAX number

+ Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application specific information

+  Software version number

+  Description of the problem such that technical support can duplicate the problem

+ If possible, save the setup files for all the instruments used and the application

+ If possible, save the TekExpress setup files, log.xml, *.TekX (session files and folders), and status messages text file

TekExpress® DisplayPort 2.0 Automated Solution 1



Getting started

Getting started

Hardware requirements

Compatibility
The TekExpress DisplayPort 2.0 application runs on the following Tektronix oscilloscopes:

«  DPO/MSO72304DX/72504DX/73304DX Series Digital Oscilloscopes
«  DPO72304SX, DPO73304SX, DPO75002SX, DPO75902SX, DPO77002SX, DPS75004SX, DPS75904SX, and DPS77004SX

See Also

Minimum system requirements

Minimum system requirements
The following table describes the minimum system requirements for the TekExpress Displayport 2.0 application.

Table 3: System requirements

Resources Supported models

DPQ70000DX/SX series oscilloscopes with bandwidth = 21 GHz for UHBR data rates in compliance

mode.
Oscilloscope Refer Compatibility for list of compatible oscilloscopes.
Processor Same as the oscilloscope
Operating System Same as the oscilloscope (Win 10)
Memory Same as the oscilloscope
Hard Disk Same as the oscilloscope
Display Same as the oscilloscope
Software + DPOJET, Jitter and Eye Diagram Analysis Tool, v10.3.0 or later

+  Microsoft Internet Explorer 11.0 SP1 or later
+ Microsoft Photo Editor 3.0 or equivalent software for viewing image files
+ Adobe Reader 7.0 or equivalent software for viewing portable document format (PDF) files

+  SDLA software v3.0.13 or later for performing equalization of CTLE indices.

Probes TCA-SMA single-ended OR P76xx Tri-Mode probe with Probe tip: P7T6CA-292, P7T6CA-292C, P76CA-
SMP, and P76TA

Other Devices +  Microsoft compatible mouse or compatible pointing device
+  Four USB ports (two USB ports minimum)

Table continued...

TekExpress® DisplayPort 2.0 Automated Solution 12



Getting started

Resources Supported models

Accessories + Min 1x PMCABLE1M Phase matched cable pair, if you are using TCA-SMA probes.

* Min 2x SM8852 (Fairview Microwave) SMA to SMP adapter, if you are using TCA-SMA Probes.

See Also

Compatibility

Supported probes

The table provides the list of probes recommended for the DisplayPort 2.0 application.

Recommended Probe model

7625,7633 differential probe based input, which offers the most efficient test configuration, by offering inputs for all 4 differential
DisplayPort signals concurrently. This configuration precludes the testing of common mode and skew measurements..

TCA-based single-ended input (direct Tektronix oscilloscope inputs) supports both differential and single-ended tests.

Software requirements

Downloading and installing the software

Complete the following steps to download and install the latest TekExpress <Application Name> application.

1.
2.

5.

Go to www.tek.com.

Click Downloads. In the Downloads menu, select DOWNLOAD TYPE as Software and enter the application name in the MODEL OR
KEYWORD field and click SEARCH.

A, Download

DOWNLOAD TYPE MODEL OR KEYWORD

Select the latest version of software and follow the instructions to download the software. Copy the executable file into the
oscilloscope.

Double-click the executable and follow the on-screen instructions.

The software is installed at C: \Program Files\Tektronix\TekExpress\TekExpress <Application
Name>.

Select Application > TekExpress <Application Name> from the Oscilloscope menu, to open the application.

Activate the license

Activate the license using the Option Installation wizard in the TekScope application:

1.
2.

In the TekScope application menu bar, click Utilities > Option Installation. The TekScope Option Installation wizard opens.
Push the F1 key on the oscilloscope keyboard to open the Option Installation help topic.

3. Follow the directions in the help topic to activate the license.

TekExpress® DisplayPort 2.0 Automated Solution 13
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View software version and license key details

To view version information of the application, click Options > About TekExpress.

- Tektronix TekExpress DisplayPort 2.0

TekExpress® DisplayPort 2.0 Automated Solution 14



Setting up the test environment

Setting up the test environment

About setting up tests

Setup the tests by using the tabs in the Setup panel: Configure the test setup on page 28. Settings in the DUT tab use a top-down,
left-to-right logic flow, so that any parameter that affects or acts as a filter for other parameters appears either to the top of or to the left of
the affected parameters.

Test options include two views, Compliance and Advanced (selected in the DUT tab of the Setup panel), with Compliance Mode (selected
in the Configuration Setup panel). The selected view determines where the test configuration settings are displayed. The level of user
intervention required depends on the DUT Automation setting and Acquisition parameters.

+ Compliance View selected with Compliance Mode: View configuration options in the Test Selection tab of the Setup panel. Tests
will run automatically with little or no user intervention. You will not be able to change test parameters to anything that deviates from
the compliance standards. The only test configuration parameters that you can change in this mode are the Real Time Scope and the
Digital Filters (DSP), both under Global Settings.

+ Advanced View selected with Compliance Mode: View configuration options in the Configuration tab of the Setup panel. Tests will
run automatically with little or no user intervention. You will not be able to change test parameters to anything that deviates from the
compliance standards. The only configuration parameters you can change in this mode are the selected Real Time Scope, Cable filters
for Eye diagram test, and the Digital Filters (DSP) under Global Settings.

Supported tests

+ Eye Diagram Testing - An eye diagram is an indicator of quality in a serial bit stream. The display (which has symmetrical patterns
shaped similarly to eyes) represents the integrity and consistency of data streams by visualizing the transitions between 0 and 1 values
and comparing those transitions among the others in their stream.

+ Data Dependent Jitter (DDJ) Measurement - DDJ is threshold-crossing time deviations correlated to the previous bits on the current
data bit.

+ Random Jitter (RJ) Measurement - Random Jitter (RJ) is also called Gaussian jitter, is unpredictable electronic timing noise. Random
jitter typically follows a normal distribution.

+ Total Jitter (TJ) Measurement - Total Jitter (TJ) is the sum of random and deterministic jitter and is calculated for a specific BER for the
system.

* Uncorrelated Jitter (UJ) Measurement - Jitter that is bounded and correlated to the data is "Data dependent jitter" (DDJ). Removing
DDJ from Deterministic Jitter is Uncorrelated Jitter.

+ Uncorrelated Deterministic Jitter (UDJ) Measurement - Deterministic Jitter (DJ) is a type of clock or data signal jitter that is predictable
and reproducible. The peak-to-peak value of this jitter is bounded and the bounds can easily be observed and predicted. Deterministic
jitter has a known non-normal distribution. Deterministic jitter can either be correlated to the data stream (data-dependent jitter) or
uncorrelated to the data stream (bounded uncorrelated jitter).UDJ measures uncorrelated jitter which is Bounded in nature. The most
common cause of UDJ is crosstalk.

+ Low Frequency Uncorrelated Deterministic Jitter (LFUDJ)Measurement - Low Frequency UDJ measurement calculates deterministic
jitter after removal of data dependent jitter on low frequency signal.

+  SSC Down Spread Rate Measurement - SSC Down Spread measurement calculates computes the SSC modulating frequency.

+ SSC Phase Deviation Measurement - This measurement calculates SSC phase deviation in Seconds, measured at each inflection
point in the modulation profile.

+ SSC Slew Rate Measurement - This measurement calculates rate of change SSC frequency deviation in ppm (parts per million),
measured at each inflection point in the modulation profile. It is expressed in kppm/us.

+  Unit Interval Measurement - Unit Interval measurement calculates period. For clock signals, the elapsed time between consecutive
crossings of the mid reference voltage level in the direction specified; one measurement is recorded per crossing pair.

TekExpress® DisplayPort 2.0 Automated Solution 15



Setting up the test environment

See Also
Before you click start
Deskew channels

About running tests

Equipment connection setup

To run tests, you need the following equipment (for details, see Minimum System Requirements):
+ A supported Tektronix oscilloscope

«  TCA-SMA or Differential Probes (for example, P7625)

+ The device under test

+ Test fixtures

The following diagrams show different setups.
DisplayPort 2.0 setup with Differential/Tri-Mode Probe

Oscilloscope

§ p76xX Probes §

= = L1 (Positive) = o fH
g « Fixture

%@. N IR
~ - L0 (Negative) H

......

/
------ LO (Positive) =*

DUT

P76CA-SMP

1708-001

TekExpress® DisplayPort 2.0 Automated Solution
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Setting up the test environment

DisplayPort 2.0 setup with single ended TCA SMA

Oscilloscope

0
[ -—
TCASVA Kgle( D <= Matched SMA Pairs
Ended Probes
LO (Positi
_ 0 (Neg \
\Fi ture
\_ =
k & : = "
‘ DUT
1708-002
See Also
About setting up tests
Pre-Run checklist
Deskew channels
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Setting up the test environment

Individual test configuration

(=) Compliance Mode () User Defined Mode

SR

- 55C Down Spread Rate Measurement UHBR10 TP2
- LFUDJ Measurement UHBR10 TP2Z
- 55C Slew Rate Measurement UHBR10 TP2
Ul Measurement UHER10 TP2
5-TPIEQ
- Random Jitter (RJ) Measurements UHBR10 TP3_EQ
- Eye diagram testing UHBR10 TP3_EQ
Total Jitter (TJ) Measurement UHBR10 TP3_EQ
- LIDJ Measurement UHBR10 TP3_EQ
- TN Measurement [IHRR10 TP FO

Filter Flle

Cable |CAUsers\Public\TektronixiTe kAppI\catlons'| G

Filters

Clock
Recovery

Ref Levels

Preset

In the Compliance mode the you can change a couple of test specific configurations.

+  Preset selection
+  Cable filters for Eye Diagram Measurement

About running tests

After selecting and configuring tests, review the pre-run checklist and then click Start to perform the tests. The application acquires and
analyzes the data, then displays a report when the tests are complete.

While the tests are running, other applications may display windows in the background. The TekScope application takes precedence over
other applications, but you can switch to other applications using the Alt+Tab key combination. To keep the TekExpress DisplayPort 2.0
application on top, select Keep On Top from the DisplayPort 2.0 application Options menu.

Waveforms generated during the test are automatically saved when you save the related test setup, so you can run tests in pre-recorded
mode.

See Also
Before you click start
About configuring tests

About setting up tests

Before you click start

Before you run tests for the first time, do the following:

1. Understand where your test files are stored on the instrument.

TekExpress® DisplayPort 2.0 Automated Solution 18



Setting up the test environment

After you install and launch TekExpress DisplayPort 2.0, it creates the following folders on the oscilloscope:

+ Windows 10: C:\Program Files\Tektronix\TekExpress\ TekExpress DisplayPortTx 2.0
* \My Documents\My TekExpress\ DisplayPort 2.0

* \My Documents\My TekExpress\DisplayPort 2.0\ Untitled Session

Every time you launch TekExpress DisplayPort 2.0, an Untitled Session folderis created inthe DisplayPort 2.0
folder. The Untitled Session folder is automatically deleted when you exit the DisplayPort 2.0 application.

CAUTION:

Do not modify any of the session files or folders because this may result in lost data or corrupted session files. Each session
has multiple files associated with it. When you save a session, a .TekX file, and a folder named for the session and containing
the associated files, is created on the oscilloscope X: drive.

2. Map the shared My TekExpress folder as X: (X drive) on all the instruments used in test setups running Microsoft Windows Operating
System.

The My TekExpress folder has the share name format <domain><user ID>My TekExpress. Or, if the instrument is not connected
to a domain, then the share name formatis <instrument name><user ID> My TekExpress. This shared folderis
used to save the waveform files and is used during other file transfer operations.

Note: If the X: drive is mapped to any other shared folder, the application will display a warning message asking you to
disconnect the X: drive manually.

3. Make sure that the My TekExpress folder has read and write access, and that the contents are not set to be encrypted:
a. Right-click the folder and select Properties.

h. Select the General tab and then click Advanced.
c. Inthe Advanced Attributes dialog box, make sure that the option Encrypt contents to secure data is NOT selected.

Example.
My TekExpress Properties & |
23 £
General |Shan’ng I Security | Previous Versions 2.24
2:24
| Iy TekExpress 03
T File fold -
ype: ile: folder bos s
Advanced Attributes Iﬁ

Choose the settings you want for this folder,

When you dick OK or Apply on the Properties dialog, you will be
asked if you want the changes to affect all subfolders and files
as well,

Archive and Index attributes

[| Folder is ready for archiving
Allow files in this folder to have contents indexed in addition to file

properties
Compress or Encrypt attributes

["] Compress contents to save disk space
|:| Encrypt contents to secure data Details

.

—
4. Refer the pre-run checklist before you run a test.
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See Also
View test-related files on page 88
Application directories on page 87

File name extensions on page 88

Pre-Run checklist

Do the following before you click Start to run a test. If this is the first time you are running a test on a setup, refer to the information in
Before you click start.

1. Make sure that all the required instruments are properly warmed up (approximately 20 minutes).

2. Perform the Signal Path Compensation (SPC).

a. On the oscilloscope main menu, select the Utilities menu.
b. Select Instrument Calibration.

3. Deskew channels.

4. Make sure that the application is able to find the oscilloscope. If it cannot, Refer TekExpress instrument control settings on page 27 to
search for connected instruments.

Launch the DisplayPort 2.0 application.

Select the Setup panel and then click the Test Selection tab.

Select any test and then click Configure.

In the Configuration section, click Global Settings.

In the Instruments Detected section, click the drop-down arrow to the right of Real Time Scope and make sure that the correct
oscilloscope is listed.

® o o T o

See Also

Equipment connection setup

Run a test in pre-recorded mode

This option allows you to re-run a complete test using just the oscilloscope and the saved test setup files.

Note: Running the test in pre-recorded mode does not replace the existing saved test results. Instead, if you save the test under
the same name, the results are saved in a session folder named for the date and time of the session.

1. Open the Save the configured test setup on page 52.

2. Inthe Setup panel, select the DUT tab and then select Use pre-recorded waveform files.

A Run session field displays, showing the session that ran for this test. If there is more than one session that contains test data (not an

empty session folder) these are available in the Run session drop-down list. Select the desired session from the drop-down list.

Select the Acquisitions tab.

In the Set acquisition tab parameters on page 36, look in the Waveform FileName column.

If no waveform files are listed, click the ellipsis button ( k) and then locate and select the desired waveform files. Skip to step 7.

If waveform files are listed, verify that the listed files are the ones you want to use. If they are not, or if you want to add a file, do any of
the following as needed:

o o e

+ To remove a waveform file from the list, click the ellipsis button and select Remove Waveform File.
+ To replace a waveform file, click the ellipsis button, select Replace Waveform File, then locate and select the desired file.
+ To add a waveform file, click the ellipses button, select Select Waveform Files, then locate and select the waveform files.
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7. Click Start to run the test.
See Also
Before you click start on page 18

Set acquisition tab parameters on page 36
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Starting the application

To start the TekExpress DisplayPort 2.0, select Applications > TekExpress DisplayPort 2.0 from the oscilloscope menu bar.

DUTID [DUTO01 @

{+) Acquire live waveforms () Use pre-recorded waveform files

View  Compiance |

Device ‘DisplayPnrt |V | Version |CTS 2.0 |1’ | Connector |Standard |v ‘

Device Profile
Data Rates

UHBR10 UHBR13 5 UHBR20

Voltage Swing Presets SsC

Clowomy) [ 500 mvy é
Both  [v]

[Viz@oomy) [z (1200 mvy

Lane Setup Dut Automation

Selected Lanes
S o Manual ]

Signal Validation

G Prompt if validation fails | v |

Figure 3: Setup panel with compliance view

DUTID [DUTON! ()

(+ Acquire live waveforms | Use pre-recorded waveform files
vew Advanced |7

Device DisplayPort | ¥ | version [CTS 2.0 | ¥ | Gonnector [Standard | ¥ |

Device Profile
Data Rates

UHBR10 UHER13.5 UHBR20

Voltage Swing Presets S5C

Clowoomyy [ 600 mvy i

Mzeoomv [z nz00mv)

Lane Setup Dut Automation

Selected Lanes
5 e Manval ]

Signal Validation

G Prompt if validation fails ‘ v |

Figure 4: Setup panel with advanced view

TekExpress® DisplayPort 2.0 Automated Solution 22



Starting the application

During start, a "My TekExpress" folder is created in the Documents folder of the current user and gets mapped to "X" drive. When the
application is closed properly, the "X" drive gets unmapped. Session files are then stored inside the folder. If this file is not found, the
application runs an instrument discovery program to detect connected instruments before starting TekExpress DisplayPort 2.0.

To keep the TekExpress DisplayPort 2.0 application on top of any application, select Keep On Top from the options menu. If the
application goes behind the oscilloscope application, select Applications > TekExpress DisplayPort 2.0 to bring the application to the
front.

Application controls

This section describes the application controls.

Table 4: Application control description

Item Description
Options menu Menu to display global application controls.
[ostans - |

Test panel

1300

Controls that open tabs for configuring test settings and options.

Start / Stop button

Ei kR

Use the Start button to start the test run of the measurements in the selected order. If prior
acquired measurements are not cleared, then new measurements are added to the existing
set.

The button toggles to the Stop mode while tests are running. Use the Stop button to abort
the test.

Pause / Continue button

Use the Pause button to pause the acquisition. When a test is paused, this button changes
as Continue.

Clear button

Clear

J

Use the Clear button to clear all existing measurement results. Adding or deleting a
measurement, or changing a configuration parameter of an existing measurement, also
clears measurements. This is to prevent the accumulation of measurement statistics or
sets of statistics that are not coherent. This button is available only on Results panel: View
summary of test results on page 47.

A Note: This button is visible only when there are results data on the panel.

Application window move icon

il

i Tekl

Place the cursor over the top of the application window to move the application window to
the desired location

Minimize icon

2

Minimizes the application.

Table continued...
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ltem

Description

Close icon

o

Close the application.

Mini view / Normal view

@
&

Toggles the application between mini view and normal view.
Mini view displays the run messages with the time stamp, progress bar,
Start / Stop button, and Pause / Continue button.

The application moves to mini view when you click the Start button.
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Options menu functions

To access the Options menu, click K% in the upper-right corner of the application. It has the following selections:

Options menu

Default Test Setup
Open Test Setup
Save Test Setup
Save Test Setup As
Open Recent

Instrument Control Settings

Keep On Top
Email Settings

Deskew

Help
About TekExpress

Table 5: Options menu settings

Menu Function

Default Test Setup Opens a new test setup with default configurations.

Open Test Setup Opens a previously saved test setup. Displays the list of previously saved test setup file
names. Make the selection and click OK to open the test setup.

Save Test Setup Saves the current test configurations with the specified file name.

Save Test Setup As Saves the current test setup with a different file name or file type.

Open Recent

Displays the recently opened test setup file names. Make the selection and click OK to
open the test setup.

Instrument Control Settings

Detects, lists, and refreshes the connected instruments found on the specified connections
(LAN, GPIB, USB, Serial, Non-VISA Resources, TekLink, and VXI).

Keep On Top Always keeps the TekExpress DisplayPort 2.0 application on top of all the applications.
Email Settings Configures email options for test run and result notifications.

Deskew Loads oscilloscope channel deskew settings into the application.

Help Displays the TekExpress DisplayPort 2.0 help.

About TekExpress Displays the application name, version, and hyperlink to end the user license agreement.
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Configure email settings

Use the Email Settings utility to get notified by email when a measurement completes or produces any error condition. Follow the steps to
configure email settings:

Figure 5: Email settings window

10.

Select Options > Email Settings to open the Email Settings dialog box.

(Required) For Recipient email Address(es), enter one or more recipient email addresses. To include multiple addresses, separate
the addresses with commas.

(Required) For Sender’s Address, enter the email address used by the instrument. This address consists of the instrument name,
followed by an underscore, followed by the instrument serial number, then the @ symbol, and the email server ID. For example:
user@yourcompany.com.

(Required) In the Server Configuration section, type the SMTP Server address of the Mail server configured at the client location,
and the SMTP Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name, password, and host name in the corresponding fields.

A Note: If any of the above required fields are left blank, the settings will not be saved, and email notifications will not be sent.

In the Email Attachments section, select from the following options:

+ Reports: Select to receive the test report with the notification email.

+ Status Log: Select to receive the test status log with the notification email. If you select this option, then also select whether you
want to receive the full log or just the last 20 lines.

In the Email Configuration section:
+  Enter a maximum file size for the email message. Messages with attachments larger than this limit will not be sent. The default is
5 MB.

+  Enter the number in the Number of Attempts to Send field, to limit the number of attempts that the system makes to send a
notification. The default is 1. You can also specify a timeout period.

Select the Email Test Results When complete or on error check box. Use this check box to quickly enable or disable email
notifications.

To test your email settings, click Test Email.
To apply your settings, click Apply.
Click Close when finished.
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TekExpress instrument control settings

Use the TekExpress Instrument Control Settings dialog box to search the instruments (resources) connected to the application. You
can use the Search Criteria options to search the connected instruments depending on the connection type. The details of the connected
instrument is displayed in the Retrieved Instruments window.

To access, click Options > Instrument Control Settings. Select USB and LAN as search criteria for TekExpress application and click
Refresh. The connected instruments displayed in the Retrieved Instruments window and can be selected for use under Global Settings in
the test configuration section.

Figure 6: TekExpress Instrument Control Settings window

_TekExpress Instrument Control :: gs

See also

Options menu functions on page 25
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Setup panel: Configure the test setup

The Setup panel contains sequentially ordered tabs that help guide you through a typical test setup and execution process.

DUTID [DUTO01 @

{+) Acquire live waveforms () Use pre-recorded waveform files

View  Compiance |

Device ‘DisplayPnrt |V | Version |CTS 2.0 |1’ | Connector |Standard |v ‘

Device Profile
Data Rates

UHBR10 UHBR13 5 UHBR20

Voltage Swing Presets SsC

Clowomy) [ 500 mvy G
Both  [v]

[Viz@oomy) [z (1200 mvy

Lane Setup Dut Automation

Selected Lanes
S o Manual ]

Filter Setup Signal Validation

G Prompt if validation fails | v |

Figure 7: Setup panel with compliance view

DUTID [DUTON! ()

(+ Acquire live waveforms | Use pre-recorded waveform files
vew Advanced |7

Device DisplayPort | ¥ | version [CTS 2.0 | ¥ | Gonnector [Standard | ¥ |

Device Profile
Data Rates

UHBR10 UHER13.5 UHBR20

Voltage Swing Presets S5C

Clowoomyy [ 600 mvy 6

Mzeoomv [z nz00mv)

Lane Setup Dut Automation

Selected Lanes
5 e Manval ]

Filter Setup Signal Validation

G Prompt if validation fails ‘ v |

Figure 8: Setup panel with advanced view
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By default the DUT, Test Selection, Acquisitions, and Preferences tabs are displayed. The Configuration tab is available only when you set
the View option as Advance in the DUT tab. Otherwise, configuration settings for tests selected in the Test Selection tab are available
from the Configure button on the Test Selection tab.

Options selected in a preceding tab affect options available in the next tab down. For example, Device Profile settings affect the list of tests
available for selection in the Test Selection tab. However, you can switch between the tabs in any order if you need to modify your test
parameters.

Refer also
About setting up Tests

DUT: Set DUT settings

Use the DUT tab to select parameters for the device under test. The settings are global and apply to all tests for the current session. The
DUT settings available and the options in the drop-down list depends on the selections made in the settings. DUT settings also affect the
list of available tests in the Test Selection tab.

_7; TekExpress Disp : '- [ v ] @ Oo

DUTID [DUT001 (c/

| Acquire live waveforms Use pre-recorded waveform files

vew | Complance | |

Device ‘DisplayPurt |V | Version |CTS 20 |Y | Connector |Standard |Y ‘

Device Profile
Data Rates

UHBR10 UHBR135 UHBR20

Voltage Swing Presets

Clowomy [+ 6oomvy @ Bon V]
Both  [v)

[VIz@oomv) [[]3 (1200 my)

Lane Setup Dut Automation

Selected Lanes

Filter Setup Signal Validation

@ Prompt if validation fails | v |

Figure 9: Setup panel with compliance view
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_%TekExpress Disp : i v | @Q o

DUT D [DUTDO1 ()

+ Acquire live waveforms Use pre-recorded waveform files

Device DisplayPort |Y | Version |CTS 2.0 |V | Connector |Standard | v |

Device Profile
Data Rates

UHBR10 UHBR135 UHBR20

Voltage Swing Presets
Clow@omy 4600 mv)
Wz@oomvy []3 (1200 my)

Lane Setup Dut Automation

Selected Lanes

Filter Setup Signal Validation

@ Prompt if validation fails ‘ v |

Figure 10: Setup panel with advanced view

Click Setup > DUT to access the DUT parameters:

Table 6: DUT tab settings

Setting Description

DUT ID Adds an optional text label for the DUT to reports. The default value is DUT001. The
maximum number of characters is 32.

You cannot use the following characters in an ID name:

(o L2]P).

9 Open a Comments dialog box which allows you to enter optional text to add to a report.
Comments icon (to the right of the You can enter a maximum number of 256 characters. Refer Select report options to enable

DUT ID field) or disable comments which appear on the test report.

Help Open the help document with DUT page selected.

Acquire live waveforms Acquire active signals from the DUT for measurement and analysis.

Use prerecorded waveform files Run tests on a saved waveform. Refer Open (load) a saved test setup to save the test
setup.

Table continued...
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Setting

Description

View

Set the view mode of the user interface for the test session.
Select the mode of view from the drop-down:

+  Compliance
+ Advanced

The Configuration tab is hidden in the Compliance mode and is only available when the
View mode is set to Advanced.

Version

Displays the CTS version. DisplayPort 2.0 application supports only CTS 2.0 version.

Connector

Set the type of connector used for the test from the drop-down:

+ Standard
+ TypeC

Data Rates

Select one or multiple data rates for waveform acquisition from the drop-down:

« UHBR10: Ultra High Bit Rate 10 (10 Gb/S)
« UHBR13.5: Ultra High Bit Rate 13.5 (13.5 Gb/S)
« UHBR20: Ultra High Bit Rate 20 (20 Gb/S)

Voltage Swing

Set the voltage swing for the signal quality test. Only 800 mV is supported for DisplayPort
2.0.

A Note: 400 mV, 600 mV, and 1200 mV settings are not available.

Presets

Sixteen presets (PO to P15) are supported for signal test for each data rate. Click Setup to
view the set of presets. For each data rate there are individual tabs for the preset selection.

Signal Quality Preset Selection

EXTI—

[paos | .
EY - — v — .

Select All: Selects all the presets for current data rate tab.
Deselect All: Deselects all the presets for current data rate tab.
Cancel: Undo the changes and close the pop-up.

OK: Save the changes and close the pop-up.

Table continued...
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Setting

Description

SSC

Select the option for Spread Spectrum Clocking from the drop-down:

+  SSC Enable: When selected, waveforms will be acquired with SSC.
+ SSC Disable: When selected, waveforms will be acquired without SSC.

+  Both: When selected, 2 sets of waveforms will be acquired for each acquire type. One
with and one without SSC.

Lane Setup

Set the lanes to be used for the acquisition of the signal.

Click Setup button and select the desired number of test lanes for the test session. The
Link Width determines the number of test lanes.

+ 1 Lane: When selected, only one lane can be used.

+ 2 Lanes: When selected, any one lane or two lanes can be used.

+ 4 Lanes: When selected, only a lane or two lanes or four lanes can be used.

Filter Setup

Set the filter files for de-embedding the signal during acquisition.

Click Filters to browse and select the De-embed filters for acquisition on positive and
negative channels. The De-embed option is unchecked by default.

DUT Automation

DUT toggle automation is set to manual to configure the DUT manually during the test.

Signal Validation

+ Prompt if validation fails: When selected, user is prompted if pattern validation fails.
The user will be given the option to Reacquire, Use Anyway, Skip and Abort the
execution.

+  Skip test if validation fails: When selected, it will skip the corresponding test(s) if
pattern validation fails.

+ Skip validation: When selected, skips the validation for all the patterns.

+ Validate pattern but use pattern as is: Select to validate the pattern. If the validation

fails, the application retries the link training for 3 times. If the validation fails even after 3
times, then it will use the pattern as is.
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See Also

Test Selection: Select the tests on page 34

About setting up tests on page 15

Use pre-recorded waveforms for analysis on page 36

Acquire live waveforms for analysis on page 38
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Test Selection: Select the tests
Use the Test Selection tab to select DisplayPort 2.0 tests. Listed tests depend on settings in the DUT tab.

./ TekExpress Displ:

DisplayPort : Transmitter : CTS 2.0

ST R CET)

=-{~] UHBR10 ~
E-fwr

Random Jitter (RJ) Measurements UHBR10 TP2
Eye diagram testing UHBR10 TP2
Total Jitter (TJ) Measurement UHBR10 TP2
UDJ Measurement UHBR10 TP2

DDJ Measurement UHBR10 TP2
UJ Measurement UHBR10 TP2
33C Phase Deviation Measurement UHBR 10 TP2
SS5C Down Spread Rate Measurement UHBR10 TP2
LFUDJ Measurement UHBR10 TP2
S8C Slew Rate UHBR10TP2
~{v] UIUHBR10TP2
£-fv] TP3EQ

E-{~] UHBR13.5
R o

Test Description

Please select a test name to view its
description

Table 7: Test Selection tab settings

Setting Description
Deselect All, Select All Deselect or select all tests in the list.
Tests Click a test to select or deselect. Selecting a test also show details about the selected test

in the Test Description pane.

All required tests are selected in the Compliance test mode.

Schematic Displays equipment connection setup for the selected measurements. You need to select
at least a measurement before you click the Schematic button.

Show MOI Displays the MOI

See Also

Set acquisition tab parameters on page 36

About setting up tests on page 15
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Acquisitions: Set waveform acquisition settings

Use Acquisitions tab to view the test acquisition parameters. The contents displayed on this tab depends on the DUT type and the tests
selected.

DisplayPort : Transmitter : CTS 2.0

TestName Acquisition
e | » Random Jitter (RJ) Measurements UHE
@ Acquisitions Total Jitter (TJ) Measurement UHBR10
DDJ Measurement UHBR10 TP2
Preferences UJ Measurement UHBR10 TP2
SSC Phase Deviation Measurement U+
| 1SSC Down Spread Rate Measurement
| SSC Slew Rate Measurement UHBR10
Ul Measurement UHBR10 TP2
Eye height testing UHBR10 TP2
| Eye width testing UHBR10 TP2

/| Test Selection

Lane0 : UHBR10 PRBS15

Lane0 : UHBR10 PRBS31

Acquisition and Save Options
« Save All Waveforms
Delete All Waveforms After Analysis

[ Show Acquire Parameters

Table 8: Acquisition tab settings

Settings Description

View Probes View the detected probe configuration. Click View Probes button to
view the connected probes.

Refresh sources Updates the list of available channel sources as used by the Source
fields in the Device list. Click Refresh Sources button if you want to
change the channel connections in the test setup.

Acquisition and Save options Save all waveforms When selected saves all the waveforms. When it executes, all
waveforms will be saved.
Delete all waveforms after Deletes all the waveforms as soon as the execution is over.
analysis
Show acquire parameters When enabled displays the parameter name.

TekExpress DisplayPort 2.0 saves all acquisition waveforms to files by default. Waveforms are saved in a unique folder for each session
(a session is started when you click the Start button). The folder path is X : \TekExpress DisplayPort 2.0\Untitled
Session\<dutid>\<date> <time>.Images created for each analysis, XML files with result values, reports, and other
information specific to that particular execution are also saved in this folder. Saving a session moves the session file contents from the
Untitled Session folder to the specified folder name and changes the session name to the specified name.
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Set acquisition tab parameters

Use the Acquisitions tab in the Setup panel to view and set acquisition parameters for selected tests. Options available in the Acquisition
tab are depend on the selection you are using; a live waveform or a pre-recorded waveform file.

1. In the Setup panel, click the Acquisitions tab.
2. When Use pre-recorded waveform file is selected, scroll to the Waveform FileName column in the Acquisitions table. For each
acquire type row, click the ellipsis button ( k&) and select the desired waveform file or files.

3. When Acquire live waveforms is selected , the lane and channel selection tables are displayed near the top of the tab. The selections
displayed are based on the available probe setup.

+ Click View Probes to verify which probes are connected to which channels.

+ To refresh the probe configuration information displayed after changing any probes, click View Probes and then click Refresh in
the Probe Configuration dialog box.

+ To change a lane source, click in the Source column and select a channel from the drop-down list.
4. Refer Acquisitions: Set waveform acquisition settings on page 35 to select any other desired acquisition options.

See Also
Configuration: Set measurement limits for tests on page 40

About setting up tests

Use pre-recorded waveforms for analysis

Use pre-recorded waveform files to run a saved tests or to run a new test using a saved waveform from another test.
Refer Run a test in pre-recorded mode to run a saved test or new test using a pre-recorded waveform file. .

1. Open a saved test setup or create a new one.

Note: By using a saved test and if you do not want to overwrite the previous data, save this test setup using the Save As
option before proceeding.

2. Inthe Setup panel, select the DUT tab and then select Use pre-recorded waveform files. (This selection adds the Waveform
FileName column to the Acquisitions table in the Acquisitions tab.)

3. Change any other DUT parameters as desired.
4. Inthe Test Selection tab, select the desired test(s).

5. In the Acquisitions tab, locate the row for the desired test. In the Waveform FileName column, click the ellipsis button ( k) and then
select a single waveform file or multiple waveform files.

6. Perform any additional test needed, such as test configuration, and then click Start.
See Also

Before you click start

Pre-Run checklist

Set acquisition tab parameters on page 36
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Running measurements using pre-recorded waveforms

1. Inthe DUT panel, select the mode as Use pre-recorded waveform files.

B e —e © © ©

DUT ID |DuTo0! |

Acquire live waveforms + Use pre-recorded waveform files

View Run session |Run 4 : 20210205_231457 | v |
Device |DisplayPort ‘ v | Version |CTS 2.0 |V | Connector

Device FProfile

Data Rates
W|UHBR10  [|UHBR135 |+ UHBR20

Voltage Swing Presets ssC

Blozoomvy 11 600mv) @
SSC Enabl [ v

[V]2@oomv) [Tz (1200 my)

Lane Setup Dut Automation

Selected Lanes

Filter Setup Signal Validation

@ Skip validation lv]

2. Select the DUT settings based on waveforms available for running measurements. Ex: If only SSC waveforms are present then you
need to select SSC as SSC Enable.

Go to Test Selection panel, select desired tests which you want to run using pre-recorded waveforms.
Go to Acquisition panel and make sure the availability of all the desired tests.
Click on the icon present in ‘Waveform FileName’ column.

Make sure all the waveforms you have has proper naming convention. In case of differential signals, waveforms should have naming
convention; * Lane0_UHBR10 PRBS15_UHBR10_P0_800_SSCEnable_40_100_Diff Run1.wfm’ and in case of single ended signals,
waveforms should have naming convention; ‘Lane0_UHBR10 PRBS15_UHBR10_P0_800_SSCEnable_40_100_SE_Run1.wfm'. Refer
to Waveform naming convention.

7. Select all the waveforms required for running test (In order to understand what all waveforms you have to select for running each
measurement, load any existing session, and switch to pre-recorded mode then go to acquisition panel).

A L
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DisplayPort : Transmitter : CTS 2.0

. ] TestName

:v-:fRandum Jitter (RJ) Measurements UHE

"~ [Total Jitter (TJ) Measurement UHBR10

" DDJ Measurement UHBR10 TP2

*UJ Measurement UHBR10 TP2

P "ESSC Phase Deviation Measurement U+

" SSC Down Spread Rate Measurement
;SSC Slew Rate Measurement UHBR10

- EUI Measurement UHBR10 TP2

Lane0 : UHBR10 PRBS15

~ Eye heighttesting UHBR10 TP2
* Eye width testing UHBR10 TP2

Lane0 : UHBR10 PRBS31

 Acquisition and Save Options
{+Save All Waveforms
| Delete All Waveforms After Analysis

[ Show Acquire Parameters

8. Click Start button.
9. Ifany of the tests are failed to run completely and report is not generated then cross check whether you have selected the required

DUT parameters in order to run in compliance mode. In such case re-run the test by selecting appropriate DUT settings and
waveforms.

Lane0 UHBR10
Lanel UHBR13.5

800 Record Length i)EIFF
Lane2 UHBR20
Lane3

<Llane>_<Acquire Type>_<Data Rate>_<Preset>_<Voltage Swing>_<S5C>_<Record Length>_<Sample Rate>_<Probe Type>_<Run No.»

UHBR10 PRB515
UHBR135 PRBS15 PO, PO1..P15
UHBR20 PRB515

SSCEnable sample Rate Runl...Run250
S5CDisable

e.g: Lane0_UHBR135 PRBS15_UHBR13.5 PO 800 SSCDisable 40 100 SE_Runi

Figure 11: Waveform naming convention

A Note: <Run No.> is not applicable if Number of Runs is set to 1 in the Preference panel.

Acquire live waveforms for analysis

Follow the instructions to setup acquisition for a live waveform.

1.

2.
3.
4

Load a saved test setup on page 52 or Saving and recalling test setup on page 52.

In the Setup panel, select the DUT tab, enter the desired DUT ID in the corresponding field and then select Acquire live waveforms.
Select other DUT parameters as desired.

In the Test Selection tab, select the desired test(s).
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5. Inthe Acquisitions tab, do any of the following that apply:

+  Select the data sources for the lanes.
+  Select other desired acquisitions parameters.

6. Configure the tests if you have not done so already, and then click Start to run the test.

See Also
Set acquisition tab parameters on page 36

Configuration: Set measurement limits for tests on page 40
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Configuration: Set measurement limits for tests

Use Configuration tab to view and configure the Global Settings and the measurement configurations. The measurement specific
configurations available in this tab depends on the selections made in the DUT panel and Test Selection panel.

A Note: Configuration tab is available only when View is set to Advanced in the DUT panel.

Table 9: Configuration tab: Common parameters

Settings Description
Limits Editor Displays the upper and lower limits for the applicable measurement using different types of
comparisons.

@ Compliance Mode O User Defined Mode

Instruments Detected

e swie

Real Time Scope MSO733040% { GPIBS:: 1::INSTR )

Digital Filters(DSP} Options
Enable Digital Filters(DSF)

UHBR10 Bandwidth (GHz)
UHBR13 5 Bandwidth (GHz)
UHBR20 Bandwidth (GHz)

Figure 12: Configuration tab: Global settings
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Table 10: Configuration tab: Global settings

Settings Description

Instruments Detected

list.

application.

Displays the instruments connected to this application. Click on the instrument name to
open a list of available (detected) instruments.

Select Options > Instrument Control Settings and click Refresh to update the instrument

Note: Verify that the LAN and GPIB search criteria (default setting) in the
Instrument Control Settings is selected when using TekExpress DisplayPort 2.0

Digital Filter (DSP) Options

Enable Digital Filters (DSP)

|AIIows you to restrict the bandwidth of the instrument (70 GHz).

® Compliance Mode O User Defined Mode

U Measurement UHBR10 TP2
- 55C Phase Deviation Measurement UHBR10 TP2
SS5C Down Spread Rate Measurement UHBR10 TP2
- LFUIDJ Measurement UHBR10 TP2
i --55C Slew Rate UHBR10TP2

Se———

Ul UHBR10TP2

- TP3 EQ

- Random Jitter (RJ) Measurements UHBR10 TP3_EQ
Eye diagram testing UHBR10 TP3_EQ

- Total Jitter (T.1} Measurement 1IHRR10 TP3 FO

Horizontal Settings

Record Length (M) |30
Sample Rate (GS/s) [100

Filters

Clock
Recovery

Ref Levels

Preset

Figure 13: Configuration tab: Measurement settings

Table 11: Configuration tab: Measurement settings

Settings

Description
Measurements Displays the measurement groups, that are selected in the Test Selection tab. Select the
respective test group to view or modify the measurement configuration.
Scope settings
Record length Specifies the waveform record length.
Sample rate Specifies the oscilloscope's sample rate for all tests.
Table continued...
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Settings

| Description

Analyze

Mask file path

|Speciﬁes the file which contains mask information.

Clock recovery

Clock recovery method

Specifies the algorithm to use to recover the clock

PLL model Defines the order of PLL

Damping (m) Second parameter used for TYPE-Il PLL

Loop BW (MHz) Loop bandwidth is the Bandwidth of the PLL

Ref levels Timing measurements are based on the state transition times. Edges occur when a
waveform crosses the specified reference voltage levels. Set the reference voltage levels,
that the application can identify state transitions on a waveform. By default, the application
automatically chooses reference voltage levels when necessary.

Mide level Sets the middle threshold level for the rising and falling edge of the source.

Hysteresis Hysteresis sets the threshold margin to the reference level. The voltage must cross to be

recognized as changing; the margin is the relative reference level plus or minus hysteresis,
use to filter out spurious events.

Ref levels autoset basetop Method

Specifies the Base-Top method, used for all reference voltage levels when auto set occurs.

+ Auto

+  MINMAX

+  FULLHISTOGRAM
+  EYEHISTOGRAM

Preset

Preset is defined as a Pair of Pre-shoot and De-emphasis values.

A Note: The Absolute and Percentage settings in the Reference level are not available.

Preferences: Set the test run preferences

Use Preferences tab to set the application action on completion of a measurement. The Preferences tab has the feature to enable or
disable certain options related to the measurement execution.
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Number of Runs
|+ Acquire/Analyze each test  [1 times
Deskew

|/ Show alert when new deskew values are configured on TekScope

Popup Settings

[ Auto close Wamings and Informations during Sequencing

Auto close after |10 seconds

[ Auto close Error

during S

Auto close after |10 seconds

Figure 14: Preferences tab

Refer the below table for the options available in the Preferences tab:

Table 12: Preferences tab settings

Setting

Description

Number of Runs

Acquire/Analyze each test <no> times (not applicable to Custom
Tests)

Select to repeat the test run by setting the number of times. By
default, check box is disabled. Upon enabling, the default value is
10.

Deskew

Show alert when new deskew values are configured on TekScope

Popup Settings

Auto close Warnings and informations during Sequencing

Auto close after <no> seconds

Select to close the warnings and information window automatically
after the specified amount of time.

Specify the time in seconds using the edit box.

Auto close Error Messages during Sequencing. Show in Reports

Auto close after <no> seconds

Select to close the error message window automatically after the
specified amount of time.

Specify the time in seconds using the edit box.
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Status panel: View the test execution status

The Status panel contains the Test Status and Log View tabs, which provides status on the test acquisition and analysis (Test Status) and
listing of test tasks performed (Log View tab). The application opens the Test Status tab when you start to execute the test. Select the
Test Status or the Log View tab to view these items while the test execution is in progress.

View test execution status

The tests are grouped and displayed based on the Clock and Data lane. It displays the tests along with the acquisition type, acquire, and
analysis status of the tests. In pre-recorded mode, Acquire Status is not valid.

The Test Status tab presents a collapsible table with information about each test as it is running. Use the symbols to expand (El) and
collapse (E) the table rows.

TestName  Acquisition | Acquire Status  Analysis Status
& Laned A A A |
Random Jitter (RJ) Measurements UHBR10 UHBR10 PRBS15 Completed Completed
Total Jitter (TJ) Measurement UHBR10 TP2 UHBR10 PRBS15 Completed Completed
DDJ Measurement UHBR10 TP2 UHBR10 PRBS15 Completed Completed
UJ Measurement UHBR10 TP2 UHBR10 PRBS15 Completed Completed
SSC Phase Deviation Measurement UHBR10 UHBR10 PRBS15 Completed Completed

SSC Down Spread Rate Measurement UHBR10 PRBS15
UHBR10 TP2

SSC Slew Rate Measurement UHBR10 TP2  UHBR10 PRBS1S Completed Completed
Ul Measurement UHBR10 TP2 UHBR10 PRBS1S Completed Completed
Eye height testing UHBR10 TP2 UHBR10 PRBS31 Completed Completed

Completed Completed

Eye width testing UHBR10 TP2 UHBR10 PRBS31 Completed Completed

Figure 15: Test execution status view in Status panel

Table 13: Test execution status table headers

Table Header Description

Test Name Displays the measurement name.
Acquisition Describes the type of data being acquired.
Table continued...
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Table Header

Description

Acquire Status

Displays the progress state of the acquisition:
+ To be started

+  Started Acquisition
+  Completed Acquisition

Analysis Status

Displays the progress state of the analysis:

+ To be started
* InProgress
+  Completed

+ Aborted

View test execution logs

The Test Status tab displays the detailed execution status of the tests. Also, displays each and every execution step in detail with its
timestamp information. The log details can be used to troubleshoot and resolve any issue/bug which is blocking the test execution process.

3/24/2022 4 06:51 AM
:06:52

3/24/2022 4:07:15 AM :
/2479077 A-NT-R1 AM -

| Test Status

Initializing run time environment. This might take some time.
3/24/2022 4:06:30 AM :
|| 3/24/2022 4:06:30 AM :
|13/24/2022 4:06:30 AM :
3/24/2022 4:06:30 AM :
3/24/2022 4:06:30 AM :
| 3/24/2022 4:06:30 AM
i 06

Device: DisplayPort

Suite: Transmitter

ACQUISITION NAME...UHBR10 PRBS15
ACQUISITION NAME...UHBR10 PRBS31

:selededChmnels CH1 CH3
: Inttializing Autoset
AM : Horizontal settings done.

: Acquisttion for: Lane0_UHBR10 PRBS15_UHBR10_P0_800_SSCEnable_40_100_SE

: Skipping Validation for: Lane0_UHBR10 PRBS15_UHBR10_P0_800_SSCEnable_40_100_SE

: Completed acquire single sequence on scope
3/24/2022 4:06:51 AM -
: Completed acquisiion for: Lane0_UHBR10 PRBS15_UHBR10_P0_800_SSCEnable_40_100_SE
: selectedChannels: CH1,CH3
: Inttializing Autoset
: Horizontal settings done.

04 AM : Acquisttion for: Lane0_UHBR10 PRBS31_UHBR10_P0_800_SSCEnable_11_100_S

3/24/2022 4:07:06 AM :
3/24/2022 4:07:08 AM :
3/24/2022 4:07:09 AM :
3/24/2022 4:07:09 AM :
3/24/2022 4:07:10 AM :
3/24/2022 4:07:10 AM

File Path: X:\DisplayPort 2. 0\Untitled Session\DUT001'20220324_040629\Lane0_UHBR10 PRE

Skipping Validation for: Lane0_UHBR10 PRBS31_UHBR10_P0_800_SSCEnable 11 _100_SE
Completed acquire single sequence on scope

File Path: X:\DisplayPort 2.0\Untitled Session\DUT001\20220324_040629\Lane0_UHBR10 PRE
Completed acquisttion for: Lane0_UHBR10 PRBS31_UHBR10_P0_800_SSCEnable_11_100_SE
current test wim: X:\DisplayPort 2.0\Untitled Session\DUT001\20220324_040629\Lane0_UHBR
loading wimX:\DisplayPort 2 0\Untitled Session\DUT001\20220324_040629\Lane0_UHBR10 PF

Running DPOJET ..
NPALIFT anahmie ~amnlated

Figure 16: Log view in Status panel

Table 14: Status panel settings

Control

Description

Message History

Lists all the executed test operations and timestamp information.

Table continued...
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Control Description

Auto Scroll Enables automatic scrolling of the log view as information is added to the log during the test execution.
Clear Log Clears all the messages from the log view.

Save

Saves the log file into a text file format. Use the standard Save File window to navigate to and specify
the folder and file name to save the log text.
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Results panel: View summary of test results

When a test execution is complete, the application automatically opens the Results panel to display a summary of test results.

In the Results table, each test result occupies a row. By default, results are displayed in summary format with the measurement details
collapsed and with the Pass/Fail column visible.

' Description PassfFail | Details | ' Margin

> -—_-_

DDJ Measurement Lane0_UHBR10

_ UHBR10 TP2 PRBS15_UHBR10_P0_800
w W Pass oocEnable_40_100 SE_T
P2

UJ Measurement Lane0_UHBR10 0.1671
@ UHBR10 TP2

PRBS15_UHBR10_P0_800
_SSCEnable_40_100_SE_T
P2

SSCPhase Lane0_UHBR10 2.9862

., Deviation o PRBS15_UHBR10_P0_800
Measurement ¥ Pass  ggCEnable_40_100_SE_T
UHBR10 TP2 P2

SSC Down Spread Lane0_UHBR10 30.6328
@ Rate Measurement @ Pass PRBS15_UHBR10_P0_800
UHBR10 TP2 _SSCEnable_40_100_SE_T
P2 Min
S8C Down Spread Lane0_UHBR10 30.9931
+ Rate Measurement Pass PRBS15_UHBR10_P0_800
UHBR10 TP2 e _SSCEnable_40_100_SE_T
P2 Max
SSC Slew Rate Lane0_UHBR10 5256788 ppmiu
— Measurement PRBS15_UHBR10_P0_800 s
“ UHBR10TP2 P35S sscEnanle_40_100_SE_T
P2 Max
Ul Measurement Lane0_UHBR10 01
@ UHBR10 TP2 PRBS15_UHBR10_P0_800
_SSCEnable_40_100_SE_T

&) Pass

Figure 17: Results panel with measurement results

Click k& icon on each measurement in the row to expand and to display the minimum and maximum parameter values of the
measurement.

Filter the test results

Each column in the result table can be customized and displayed by enabling or disabling any column as per your requirement. You can
change the view in the following ways:

+To remove or restore the Pass/Fail column, select Preferences > Show Pass/Fail.

+ To collapse all expanded tests, select Preferences > View Results Summary.

+ To expand all the listed tests, select View Results Details from the Preferences menu in the upper right corner.

+ To enable or disable the wordwrap feature, select Preferences > Enable Wordwrap.

+ To view the results grouped by lane or test, select the corresponding item from the Preferences menu.

+ To expand the width of a column, place the cursor over the vertical line that separates the column from the column to the right. When
the cursor changes to a double-ended arrow, hold down the mouse button and drag the column to the desired width.

+ To clear all test results displayed, click Clear.
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Reports panel: Configure report generation settings

Click Reports panel to configure the report generation settings and select the test result information to include in the report. You can use
the Reports panel to configure report generation settings, select test content to include in reports, generate the report, view the report,
browse for reports, name and save reports, and select report viewing options.

Select report generation options

This section describes the report generation settings you can configure in the Reports panel. Select report settings before running a test or
when creating and saving test setups. Report settings configured are included in saved test setups.

Figure 18: Reports panel

Report Update Mode Settings
Table 15: Report Update Mode Settings

Control Description

Generate new report Each time when you click Run and when the test execution
is complete, it will create a new report. The report can be in
either .mht, .pdf, or .csv file formats.

Append with previous run session Appends the latest test results to the end of the current test results
report. Each time when you click this option and run the tests, it will
run the previously failed tests and replace the failed test result with
the new pass test result in the same report.

Include header in appended reports Select to include header in appended reports.
Table continued...
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Control

Description

Replace current test in previous run session

Replaces the previous test results with the latest test results.
Results from newly added tests are appended to the end of the
report.

In previous run, current session

Select to replace current test results in the report with the test
result(s) of previous run in the current session.

In any run, any session

Select to replace current test results in the report with the test
result(s) in the selected run session’s report. Click and select test
result of any other run session.

Report Creation Settings

Report name

Displays the name and path of the <Application Name>

report. The default location is at \My Documents>\My
TekExpress\<Application Name>\Reports.The
report file in this folder gets overwritten each time you run a test
unless you specify a unique name or select to auto increment the
report name.

To change the report name or location, do one of the following:

* Inthe Report Path field, type the current folder path and name.

+  Double-click in the Report Path field and then make selections
from the popup keyboard and click Enter.

Be sure to include the entire folder path, the file name,

and the file extension. For example: C: \Documents
and Settings\your user name\My
Documents\My TekExpress\<Application
Name> \DUTO001.mht

Note: You cannot set the file location using the Browse
button.

Open an existing report

Click Browse, locate and select the report file and then click View
at the bottom of the panel.

Save as type

Saves a report in the specified file type, selected from the drop-
down list. The report is saved in .csv, .pdf, or .mht.

Note:

If you select a file type different from the default, be sure to
change the report file name extension in the Report Name
field to match.

Auto increment report name if duplicate

Sets the application to automatically increment the name of the
report file if the application finds a file with the same name as the
one being generated. For example: DUT001, DUT002, DUT003.
This option is enabled by default.

Create report automatically at the end of the run

Select to create the report with the settings configured, at the end of
run.

Table continued...
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Control

Description

Contents To Save Settings

Include pass/fail info in details table

Select to include pass/fail information in the details table of the
report.

Include detailed results

Select to include detailed results in the report.

Include plot images

Select to include the plot images in the report.

Include setup configuration

Sets the application to include hardware and software information in
the summary box at the top of the report. Information includes: the
oscilloscope model and serial number, the oscilloscope firmware
version, and software versions for applications used in the
measurements.

Include complete application configuration

Select to include the complete application configuration in the
report.

Include user comments

Select to include any comments about the test that you or another
user have added in the DUT tab of the Setup panel. Comments
appear in the Comments section, below the summary box at the
beginning of each report.

Include statics table

Select to include test run statistics in the report. This is enabled
when you run any test for more than once. Set Acquire/Analyze
each test in the Preferences tab to more than one, to run any test
for multiple times.

Include Informative Results

Select to include results for informative tests.

Other settings in report panel

View report after generating

Automatically opens the report in a Web browser when the test
execution is complete. This option is selected by default.

View

Click to view the most current report.

Generate Report

Generates a new report based on the current analysis results.

Save As Specify a name for the report.

Group Report By

Test Name Select to group the test results based on the test name in the report.
Test Result Select to group the test results based on the test result in the report.
Lane Name Select to group the test results based on the Lanes in the report
Data Rate Select to group the test results based on the Data Rate in the report
Images Select to group the test results based on the image in the report
Report Type

Compliance Select to include compliance results

All results Select to include all results.
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View a generated report

Sample report and its contents

A report shows detailed results and plots, as set in the Reports panel.

el(fronix

TekExpress Display Port Tx 2.0

Transmitter Test Report

DUT ID DuTOoO01 DPOJET Version "10.4.0.7"
Date /Time 3/21/2022 1:43:56 AM Scope Model DPO733 045X
Device Type DisplayPort Scope Serial Number QUO00062
CTS Varsion CTS 2.0 Scope Version CF91.0CTFV:10.12.1 Euild 26
Connector Standard SDLA Version 3.0.12.31
Test Mode Compliance Probel Maodel “TCA292D"
DUT Control Manual Probel Serial Number "N/AT

55C EBoth Frobe? Model “TCAZ92D"
TekExpress Version Framework: 5.2.0.25 Probe2 Serial Number "N/AT

App Version Display Port Tx 2.0: 10.4.2.10 Frobe3 Model “TCAZ92D"
Execution Mode Live Probe3 Serial Mumber TN AT
Acquisition Duration 00:01:10 Probe4 Model *TCAZ92D"
Analysis Duration 00:13:22 Probe4 Serial Number NSAT
Onerall Execution Duration 00:14:35

Owerall Test Result Pass

DUT COMMENT

| General Com ment - Dis playPort

Random Jitter (R)) Measurements UHER10 TFZ

Ewe height testing UHBR10 TP2

Eve width testing UHER10 TP2

Total Jitter (T)} Measurement UHER10 TP2

UDJ Measurement UHERT O TP2

DDJ Measurement UHER10 TF2

Ul Measuremeant UHERTO TP2

R

SSC Pt Deviation 1 BRIO TR

Info mative

55C Down Spread Rate Measurement UHER10 TP2

Info rm ative

LFUDJ Measu rem ent UHER1 O TP2

Info rmative

5SC Slew Rate Measurement UHER10 TP2

Info mative

Ul Measurement UHER1O TF2

Info rmative

Random litter (R Measurements UHER10 TP3 EQ

Eve height testing UHBR10 TP2_EQ

g

Eve width testing UHER10 TF3_EQ

Total Jitter (T)) Measurement UHBR10 TP3_ECQ

UD) Measurement UHER10 TP3_EQ

DDl Measurement UHER10 TP3 EQ

Ul Measurement UHER1O TP2_EQ

HEEH

Total Measurements Executed : 44 : Pass = 28 : Fail

= 0:Skipped =0 : Error = 0 : Inform ative = 16

Wim Name Optimum CTLE(dB} DFE Tap Valus
Lane0_UHER10 PREST5_UHER1 D_FO_800_SSCEnabl | _, ey
e_40_100_SE .
Lane0_UHBR10 PRES15_UHERI 0_PO_800_S5CDisab | _

le_40_100_SE e 49.02
Lane0_UHER10 PRES21_UHERI 0_PO_800_SSCEnabl | _

e_1_100_SE g 48.94
Lane0_UHER10 PRES31_UHERID_F0_800_S5CDisab | e
le_1_100_SE i

Figure 19: Report for DisplayPort2.0

Setup Information

Test Name Summary Table
Measurement
User comments

Optimum CTLE Table

TekExpress® DisplayPort 2.0 Automated Solution

The summary box at the beginning of the report lists setup configuration information. This information
includes the oscilloscope model and serial number, optical module model and serial number, and software
version numbers of all associated applications.

The test summary table lists all the tests which are executed with its result status.
The measurement table displays the measurement related details with its parameter value.

If you had selected to include comments in the test report, any comments you added in the DUT tab are
shown at the top of the report.

The Optimum CTLE Table shows the details of the optimum CTLE for all TP3_EQ measurements.
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Saving and recalling test setup

Test setup files overview

Saved test setup information (such as the selected oscilloscope, general parameters, acquisition parameters, measurement limits,
waveforms (if applicable), and other configuration settings) are saved under the setup name at X:\<Application Name>.

Use test setups to:

* Run a new session, acquire live waveforms, using a saved test configuration.
+ Create a new test setup using an existing one.

+ View all the information associated with a saved test, including the log file, the history of the test status as it executed, and the results
summary.

+ Run a saved test using saved waveforms.

Save the configured test setup

You can save a test setup before or after running a test. You can create a test setup from already created test setup or using a default
test setup. When you save a setup, all the parameters, measurement limits, waveform files (if applicable), test selections, and other
configuration settings are saved under the setup name. When you select the default test setup, the parameters are set to the application’s
default value.

Select Options > Save Test Setup to save the opened setup.

Select Options > Save Test Setup As to save the setup with different name.

Load a saved test setup

To open (load) a saved test setup, do the following:

+ Select Options > Open Test Setup.
+  Select the setup from the list and click Open. Setup files are located at X:\<Application Name>.

Select a pre-run session from the loaded test setup

Complete the following steps to load a test setup from a pre-run session:

1. Select Options > Open Test Setup.

2. Select a setup from the list and then click Open. Setup files are located at X : \<Application Name>\.
3. Switch the mode to Pre-recorded waveform files in the DUT panel.

4. Select the required waveforms from the selected setup in the Acquisition tab and Run the required test.
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Save the test setup with a different name

To create a test setup with a different name, follow the steps:

Select Options > Open Test Setup.

Select a setup from the list and then click Open.

Click application setup and modify the parameters.
Click application reports and modify the report options.
Select Options > Save Test Setup As.

Enter the test setup name and click Save.

S gk~ Db =
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SCPI Commands

About SCPl command

You can use the Standard Commands for Programmable Instruments (SCPI) to communicate remotely with the TekExpress application.
Complete the TCPIP socket configuration and the TekVISA configuration in the oscilloscope or in the device where you are executing the
script.

Note: If you are using an external PC to execute the remote interface commands, then install TekVISA in the PC to make the
configurations.

Socket configuration for SCPl commands

This section describes the steps to configure the TCPIP socket configuration in your script execution device and the steps to configure the
TekVISA configuration in the oscilloscope to execute the SCPI commands.

TCPIP socket configuration

1. Click Start > Control Panel > System and Security > Windows Firewall > Advanced settings.

& Control Panel\System and Security\Windows Defender Firewall O X
<« v 1 & > Control Panel > System and Security > Windows Defender Firewall v U  SearchCo.. P
Help protect your PC with Windows Defender Firewall ~

Control Panel Home

Windows Defender Firewall can help prevent hackers or malicious software from gaining access to your PC

Allow an app or feature through the Internet or a network.
through Windows Defender

Firewall
o For your security, some settings are managed by your system administrator.

G Change notification settings

& Turn Windows Defender
Firewall on or off

G Restore defaults
G Advanced settings

Troubleshoot my network

See also
Security and Maintenance

Network and Sharing Center

Connected

l 9 Domain networks

Networks at a workplace that are attached to a domain

Windows Defender Firewall state: On

Incoming connections: Block all connections to apps that are not on the list

of allowed apps
Active domain networks: B tektronixnet

Notification state: Do not notify me when Windows Defender Firewall

blocks a new app

l 9 Private networks

l 9 Guest or public networks

Networks in public places such as airports or coffee shops

Not connected

Connected

Windows Defender Firewall state: On

Incoming connections: Block all connections to apps that are not on the list

of allowed apps

Active public networks: ¥ globaltektronixnet

Notification state: Do not notify me when Windows Defender Firewall

blocks a new app

v

2. In Windows Firewall with Advanced Security menu, select Windows Firewall with Advanced Security on Local Computer >
Inbound Rules and click New Rule...

TekExpress® DisplayPort 2.0 Automated Solution
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B Windows Defender Firewall with Advanced Security - [m]
File Adion View Help
oo 2@ 2 BE
B e e T
g‘:&"ﬂjz'ﬂja Name Group : Profile  Enabled  Action * || Inbound Rules -
¥ Connection Security Rules W NewRule.
> Monitoring T Filter by Profile »
Y Filter by State »
Y Filter by Group »
View »
(@ Refresh
5 Export List..
H Hep
3. In New Inbound Rule Wizard menu
a. Select Port and click Next.
ﬂ New Inbound Rule Wizard
Rule Type
Select the type of firewall rule to create
Steps:
@ Rule Type What type of rule would you like to create?
@ Protocol and Ports
@ Action () Program
@ Profile Rule that controls connections for a program
@ Name @® Port
Rule that controls connections for a TCP or UDP port.
() Predefined-
@FirewallAPI.dlI,-80200
Rule that controls connections for 3 Windows experience
() Custom
Custom rule.

b. Select TCP as rule apply, enter 5000 for Specific local ports and click Next.

TekExpress® DisplayPort 2.0 Automated Solution
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ﬂ New Inbound Rule Wizard X
Protocol and Ports
Specify the protocols and ports to which this rule applies.
Steps:
@ Rule Type Does this rule apply to TCP or UDP?
@ Protocol and Ports @® TCP
@ Action O ubP
@ Profile
® Name Does this rule apply to all local ports or specific local ports?

O Al local ports

(@ Specific local ports: |5000|

Example: 80, 443, 5000-5010
c. Select Allow the connection and click Next.
X

0 New Inbound Rule Wizard
Action
Specify the action to be taken when a connection matches the conditions specified in the rule.

Steps:
@ Rule Type What action should be taken when a connection matches the specified conditions?
@ Protocol and Ports
pon (@ Allow the connection
bd on This includes connections that are protected with IPsec as well as those are not.
@ Profile
N () Allow the connection if it is secure
@ Hame This includes only connections that have been authenticated by using IPsec. Connections
will be secured using the settings in |Psec properties and rules in the Connection Security
Rule node

Customize

() Block the connection

d. Select Domain, Private, Public checkbox and click Next.
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0 New Inbound Rule Wizard X
Profile
Specify the profiles for which this rule applies.
Steps:
@ Rule Type When does this rule apply?
@ Protocol and Ports
@ Action Domain
@ Profile Applies when a computer is connected to its comporate domain.
@ Name Private

Applies when a computer is connected to a private network location, such as a home

orwork place.

Public
Applies when a computer is connected to a public network location.
e. Enter Name, Description (optional), and click Finish.
X

‘ New Inbound Rule Wizard

Specify the name and description of this rule.

Steps:
Rule Type
Protocol and Ports

Action
Name:

‘ TekExpress

Profile

¢ ¢ & & &

Name
Description (optional):

4, Check whether the Rule name is displayed in Windows Firewall with Advanced Security menu > Inbound Rules.
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' Windows Defender Firewall with Advanced Security
File Action View Help
o9 5@ =B e}

E23 Inbound Rules

Name
K3 Outbound Rules ) )
%% Connection Security Rules @ Techsmith Snagit

> B Monitoring 9 TekExpress

9 TekExpress D-PHY(In)
9 TekExpress M-PHY Tx(In)
9 TekVISARM software
@ TrendUpdateAgent

@ TrendUpdateAgent

@ vNC_TCP_5800

@ VNC_TcP_5900

@ VPN_UDP_62515

@ VPN_UDP_62515

1 TekExpress Application Port (In)
9 TekExpress Automotive PAM3 Analysis(in)

P Windows Defender Firewall witt It L) Actions

gin_1000.16299...

r_1.02092..

2 41.16299492...

OneConnect_3.1811.30820_x6...

AAD
@ @{MicrosoftD pp

1 @MicrosoftMessaging_4.1810.2922.0_x64...
9

9

9

9 dows.Cl

9 Windows.Cl

9

Windows Cortana_1.96.16299...

@ @Microsoft Windows.Photos_2018.18091...
1 @MicrosoftWindows.Photos_2019.19081...

kHub_1.180..

< > <

>_11810.1001.12...

X
Group Profile  Enabled  Action * || Inbound Rules -
Al Yes Allow & NewRule
Al s Allow Y Filter by Profile »
Al Yes Allow
Al Yes Allow Y Filter by State >
Al Yes Allow Y Filter by Group »
Al Yes Allow View »
Al Yes Allow
Private,. Yes Allow i Refresh
Private,. Yes Allow iz Export List..
Domain  Yes Allow B ep
Domain  Yes Allow
Private... Yes Allow
Domain  Yes Allow
AAD gi. Domai. Yes Allow
ppinst.. Domai.. Yes Allow
@{MicrosoftMessaging_418.. Al Yes Allow
.. Domai. Yes Allow
OneConnect 3.1.. Domai.. Yes Allow
Cloud. Domai.. Yes Allow
Cloud. Domai.. Yes Allow
Cloud. Domai.. Yes Allow
Corta. Domai.. Yes Allow
@{MicrosoftWindows Photo.. Al Yes Allow
@MicrosoftWindows Photo.. Al Yes Allow
.. Domai. Yes Allow
Mi - Al Yes Allow
>

TekVISA configuration

1. Click Start > All Programs > TekVISA > OpenChoice Instrument Manager.

OpenChoice Instrument Manager
File Edit Help
Instruments

<

Last Updated: 9/11/2020 2:42 AM

Instrument List
Update

Search Criteria..

2. Click Search Criteria. In Search Criteria menu, click LAN to Turn-on. Sele

the TekExpress device in Hostname and type Port as 5000. Click to configure the IP address with Port.

Applications and Utilities

OpenChoice Call Monitor
OpenChoice Talker Liste. ..

Start Application or Utility

v

Tektronix

ct Socket from the drop-down list, enter the IP address of

Enter the Hostname as 127.0.0.1 if the TekVISA and TekExpress application are in the same system, else enter the IP address of the
oscilloscope where the TekExpress application is running.
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Search Criteria EI@

v Search LAN

Parameters
[ Auto Discovery Y

Hostname Part

=Rl 4000 |
[Backel] 127 .0.0.1 5000
Bockefl 134 64 244 227 5000

Serial

Daone

=

3. Click Search to setup the TCPIP connection with the host. Check whether the TCPIP host name is displayed in OpenChoice
Instrument Manager > Instruments.
] OpenChoice Instrument Manager = Search Criteria

Fle Edt Help

Instruments Applications and Utilities

GPIBR 1 INSTE OpenChoice Call Monitor ¥ Search LAN

okl TC PP 127.0.0.1: 5000:: SOCKET | OpenChoice Talker Liste e
I~ Aute Discovery

Hostname Part

EBeskell1 27.0.0.1 5000
[Backel] 134.64 244 227 5000

0l m |y Delete Search

Last Updated: 9/11/2020 2:55 AM

Instrument List Instrument
Update Identify

Search Criteria Properties

4. Double-click OpenChoice Talker Listener and enter the Command *IDN? in command entry field and click Query. Check that the
Operation is successful and Talker Listener Readout displays the Command / Data.
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a OpenChaice Talker Listener

File Edit Tools Help

Instrurments

[GPIE|GPIBS::1::INSTR
[Socket| TCPIP::127.0.0.1::5000:: SOCKET

Last Updated 8/11/2020 3:02 A

Update Reset Comrmunications

&

Talker Listener Readout:

Date / Time

Duration

Source

Step Laop

Cormmand / Data

Comrmand Type

91152020 3:.03 .
9172020 3:03 ...
912020 3:03 .

0.1456¢
0.0007 s
0.0011s

& Operation Successful

WISA

DPO77..
GPRIBE:...

GPIBB:1:INSTR
*DN?
TEKTRONIX, DPO770025K B300079,C....

Cpen Session
Write
Read

Set or query the device name of application
This command sets or queries the device name of the application.

Syntax

TEKEXP:SELECT DEVICE, "<DeviceName>" (Set)
TEKEXP:SELECT? DEVICE (Query)

Command arguments

Argument Name Argument Type
<DeviceName> <String>
Returns

<String>

Examples

TEKEXP:SELECT DEVICE, "<DUT001>" command sets the device name of the application to DUT001.

TEKEXP:SELECT? DEVICE command returns the selected device name of the application.

Set or query the DUTID of application

This command sets or queries the DUTID of the application.

Syntax

TEKEXP:VALUE DUTID, "<Value>" (Set)

TEKEXP:VALUE? DUTID (Query)
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Command arguments

Argument Name Argument Type
<Value> <String>
Returns

<String>

Examples

TEKEXP:VALUE DUTID, "DUT001" command sets the DUTID of the application to DUT001.

TEKEXP:VALUE? DUTID command returns the DUTID of the application.

Set or query the suite name of the application
This command sets or queries the suite name of the application.

Syntax

TEKEXP:SELECT SUITE, "<SuiteName>" (Set)
TEKEXP:SELECT? SUITE (Query)

Command arguments

Returns

<String>

Examples

TEKEXP:SELECT SUITE, "<SuiteName>" command sets the suite name of the application.

TEKEXP:SELECT? SUITE command returns the selected suite of the application.

Set or query the test name of the application
This command selects or deselects the specified test name of the application.
Syntax

TEKEXP:SELECT TEST, "<TestName>", <Value> (Set)
TEKEXP:SELECT TEST, "<ALL>" (Set)

TEKEXP:SELECT? TEST (Query)
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Command arguments

TestName

Value

Eye Diagram Testing

Data Dependent Jitter (DDJ) Measurement

Random Jitter (RJ) Measurement

Total Jitter (TJ) Measurement

Uncorrelated Jitter (UJ) Measurement

Uncorrelated Deterministic Jitter (UDJ) Measurement

Low Frequency Uncorrelated Deterministic Jitter
(LFUDJ)Measurement

SSC Down Spread Rate Measurement
SSC Phase Deviation Measurement
SSC Slew Rate Measurement

Unit Interval Measurement

{True | False} or {1] 0}

It represents selected or unselected.
Where,

True or 1 - Selected

False or 0 - Unselected

Returns
{True | False} or {1 | 0}

Examples

TEKEXP:SELECT TEST, "<TestName>", 1 command selects the specified test in the Test Panel.

TEKEXP:SELECT TEST, "<ALL>" command select all the tests in the Test Panel.

TEKEXP:SELECT? TEST command returns the list of selected tests.

Set or query the version name of the application

This command sets or queries the version name of the application.

Syntax

TEKEXP:SELECT VERSION, “<VersionName>" (Set)

TEKEXP:SELECT? VERSION (Query)

Command arguments

Argument Name Argument Type Valid Values

<VersionName> <String> It is the name of the version on the DUT panel of the application.
Returns

<String>

Examples

TEKEXP:SELECT VERSION, “<VersionName>” command sets the version name of application.

TEKEXP:SELECT? VERSION command returns the version name of application.
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Set or query the general parameter values

This command sets or queries the general parameter values of the application.

Syntax
TEKEXP:VALUE GENERAL, "<ParameterName>", "<Value>" (Set)

TEKEXP:VALUE? GENERAL, "<ParameterName>" (Query)

Command arguments

Table 16: General command parameters

ParameterName Value
Connector «  Standard

+ TypeC
UHBR10 * Included

* Excluded
UHBR13.5 . Included

* Excluded
UHBR20 * Included

*  Excluded
Voltage swing-800mV « Included

+  Excluded
SignalPreset_UHBR10 . PO

P01

+ P02

+ P03

+ P04

« P05

+ P06

« PO7

+ P08

+ P09

« P10

« PN

+ P12

« P13

+ P14

« P15

Table continued...
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ParameterName

Value

SignalPreset_UHBR13.5

. P01
)
. P03
. P04
. P05
. P06
. P07
. P08
. P09
.+ P10
- PN
. P12
- P13
. P14
.+ P15

SignalPreset_UHBR20

+ PO

+ PO1
+ P02
+ P03
+ P04
+ P05
+ P06
+ PO7
+ P08
+ P09
+ P10
+ P11
+ P12
+ P13
+ P14
+ P15

SSC

+ SSC Enable
+ SSC Disable
* Both

Link Widths

* 1Llane
* 2Llanes
* 4 Llanes

Table continued...
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ParameterName

Value

DUT control

Manual

FilterfileDeEmbedPos

C:\Users\Public\Tektronix\TekApplications\DisplayPort20\Filters\RF _
Cable_Deembed_POS fit

FilterfileDeEmbedNeg

C:\Users\Public\Tektronix\TekApplications\DisplayPort20\Filters\RF _
Cable_Deembed_Neg.flt

Signal Validation

+  Skip validation

+  Skip test if validation fails

+  Prompt if validation fails

+ Validate pattern but use pattern as is

Number of Runs 110250
Timer Warning Info Message Popup « TRUE
+ FALSE
Timer Warning Info Message Popup Duration 11060
Timer Error Message Popup « TRUE
+ FALSE
Timer Error Message Popup 11060
Table 17: Report panel command parameters
<ParameterName> <Value>
Report Update Mode ¢ New
*  Append
* Replace
Report Path X:\<application name>\Reports\DUT001.mht
Save As Type « Web Archive (*.mht:*.mhtmi)

+ PDF (*.pdf;)
« CSV (*.csv))

Auto increment report name if duplicate

{True | False} or {1 0}
It represents selected or unselected.
Where,

+ Trueor1- Selected
+ False or 0 - Unselected

Table continued...
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<ParameterName>

<Value>

Create report at the end

{True | False} or {1] 0}

It represents selected or unselected.

Where,

* Trueor 1 - Selected
+ False or 0 - Unselected

Include Pass/Fail Results Summary

{True | False} or {1] 0}

It represents selected or unselected.

Where,

* Trueor 1 - Selected
+ False or 0 - Unselected

Include Detailed Results

{True | False} or {1 0}

It represents selected or unselected.

Where,

* True or 1 - Selected
+ False or 0 - Unselected

Include Plot Images

{True | False} or {1 0}

It represents selected or unselected.

Where,

+ Trueor 1 - Selected
+ False or 0 - Unselected

Include Setup Configuration

{True | False} or {1 | 0}

It represents selected or unselected.

Where,

* Trueor 1 - Selected
+ False or 0 - Unselected

Include Complete Application Configuration

{True | False} or {1 | 0}

It represents selected or unselected.

Where,

* Trueor 1 - Selected
+ False or 0 - Unselected

Table continued...
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<ParameterName>

<Value>

Include User Comments

{True | False} or {1] 0}

It represents selected or unselected.

Where,

* Trueor 1 - Selected
+ False or 0 - Unselected

Returns
<NRf> or <String>
Examples

TEKEXP:VALUE GENERAL, "<ParameterName>", "<Value>" command set the value for the specified general

parameter.

TEKEXP:VALUE? GENERAL, "<ParameterName>" command returns the value for the specified general parameter.
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Set or query the acquire parameter values

This command sets or queries the acquire parameter values of the application.

Syntax

TEKEXP :VALUE
ACQUIRE, "<TestName>", ”"<AcquireType>”, ”<ParameterName>", "<ParameterValue>" (Set)

TEKEXP:VALUE? ACQUIRE, “<TestName>",”<AcquireType>”,”<ParameterName>" (Query)

Command arguments

TestName AcquireType ParameterName ParameterValue
Eye Diagram Testing PRBS15 SignalPreset . PO
Data Dependent Jitter (DDJ) Measurement . PO1
Random Jitter (RJ) Measurement + P02
Total Jitter (TJ) Measurement + P03
Uncorrelated Jitter (UJ) Measurement + P04
Uncorrelated Deterministic Jitter (UDJ) Measurement + POS
Low Frequency Uncorrelated Deterministic Jitter (LFUDJ) * P06
Measurement + P07
SSC Down Spread Rate Measurement + P08
SSC Phase Deviation Measurement * P09
SSC Slew Rate Measurement El?
Unit Interval Measurement . P12
¢« P13
+ P14
+ P15

Returns
<Nrf>
Examples

TEKEXP : VALUE
ACQUIRE, “<TestName>", "<AcquireType>”, "<ParameterName>", "<ParameterValue>" command sets
the value for the specified test and its acquire parameter.

TEKEXP:VALUE? ACQUIRE, "<TestName>", ”<AcquireType>”, "<ParameterName>" command returns the
value for the specified test and its acquire parameter.

Set or query the analyze parameter values

This command sets or queries the analyze parameter values of the application.
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Syntax
TEKEXP:VALUE ANALYZE, ”<TestName>", "<ParameterName>", "<ParameterValue>" (Set)

TEKEXP:VALUE? ANALYZE, “<TestName>", "<ParameterName>" (Query)

Command arguments

TestName ParameterName ParameterValue
Eye Diagram Testing Cable filter file File Path
Returns

<Nrf>

Examples

TEKEXP:VALUE ANALYZE, “<TestName>", "<ParameterName>", "<ParameterValue>" command set the
value for the specified test and its analyze parameter.

TEKEXP:VALUE? ANALYZE, “<TestName>", "<ParameterName>" command returns the value for the specified test
and its analyze parameter.

Query the available devices in the DUT panel of the application

This command queries the list of available devices on the DUT panel as comma separated values.

Syntax

TEKEXP:LIST? DEVICE (Query)

Command arguments

Device Device Type and value Description

<Device> <String> Itis the name of the device on the DUT panel of the application.
Returns

<String>

Examples

TEKEXP:LIST? DEVICE command returns the list of available devices.

Query the available suites for the selected device

This command queries the list of available suites for the selected device as comma separated values.
Syntax

TEKEXP:LIST? SUITE (Query)
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Returns
<String>
Examples

TEKEXP:LIST? SUITE command returns the list of available suites for the selected device.

Query the list of available tests of the application

This command queries the list of available tests of the application for the selected device as comma separated values.
Syntax

TEKEXP:LIST? TEST (Query)

Command arguments

NA
TestName String
Eye height testing Eye height testing UHBR10 TP2

Eye height testing UHBR10 TP3
Eye height testing UHBR13.5 TP2
Eye height testing UHBR13.5 TP3
Eye height testing UHBR20 TP2
Eye height testing UHBR20 TP3
Eye width testing Eye width testing UHBR10 TP2
Eye width testing UHBR10 TP3
Eye width testing UHBR13.5 TP2
Eye width testing UHBR13.5 TP3
Eye width testing UHBR20 TP2
Eye width testing UHBR20 TP3
Data Dependent Jitter (DDJ) Measurement | Data Dependent Jitter (DDJ) Measurement UHBR10 TP2
Data Dependent Jitter (DDJ) Measurement UHBR10 TP3
Data Dependent Jitter (DDJ) Measurement UHBR13.5 TP2
Data Dependent Jitter (DDJ) Measurement UHBR13.5 TP3
Data Dependent Jitter (DDJ) Measurement UHBR20 TP2
Data Dependent Jitter (DDJ) Measurement UHBR20 TP3
Random Jitter (RJ) Measurement Random Jitter (RJ) Measurement UHBR10 TP2
Random Jitter (RJ) Measurement UHBR10 TP3
Random Jitter (RJ) Measurement UHBR13.5 TP2
Random Jitter (RJ) Measurement UHBR13.5 TP3

(RJ)

(RJ)

Random Jitter (RJ) Measurement UHBR20 TP2
Random Jitter (RJ) Measurement UHBR20 TP3

Table continued...
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TestName

String

Total Jitter (TJ) Measurement

Total Jitter (TJ) Measurement UHBR10 TP2

Total Jitter (TJ) Measurement UHBR10 TP3

Total Jitter (TJ) Measurement UHBR13.5 TP3

(TJ)
(TJ)
Total Jitter (TJ) Measurement UHBR13.5 TP2
(TJ)
(TJ)

Total Jitter (TJ) Measurement UHBR20 TP2

Total Jitter (TJ) Measurement UHBR20 TP3

Uncorrelated Jitter (UJ) Measurement

Uncorrelated Jitter (UJ) Measurement UHBR10 TP2

Uncorrelated Jitter (UJ) Measurement UHBR10 TP3

Uncorrelated Jitter (UJ) Measurement UHBR13.5 TP2

(W)
(W)
Uncorrelated Jitter (UJ) Measurement UHBR13.5 TP3
Uncorrelated Jitter (UJ) Measurement UHBR20 TP2

Uncorrelated Jitter (UJ) Measurement UHBR20 TP3

Uncorrelated Deterministic Jitter (UDJ)
Measurement

Uncorrelated Deterministic Jitter (UDJ) Measurement UHBR10 TP2

Uncorrelated Deterministic Jitter (UDJ) Measurement UHBR10 TP3

Uncorrelated Deterministic Jitter (UDJ) Measurement UHBR13.5 TP3

)
(UDJ)
Uncorrelated Deterministic Jitter (UDJ) Measurement UHBR13.5 TP2
(UDJ)
(UDJ)

Uncorrelated Deterministic Jitter (UDJ) Measurement UHBR20 TP2

Uncorrelated Deterministic Jitter (UDJ) Measurement UHBR20 TP3

Low Frequency Uncorrelated Deterministic
Jitter (LFUDJ)Measurement

Low Frequency Uncorrelated Deterministic Jitter (LFUDJ)Measurement UHBR10 TP2

Low Frequency Uncorrelated Deterministic Jitter (LFUDJ)Measurement UHBR13.5 TP2

Low Frequency Uncorrelated Deterministic Jitter (LFUDJ)Measurement UHBR20 TP2

SSC Down Spread Rate Measurement

SSC Down Spread Rate Measurement UHBR10 TP2

SSC Down Spread Rate Measurement UHBR13.5 TP2

SSC Down Spread Rate Measurement UHBR20 TP2

SSC Phase Deviation Measurement

SSC Phase Deviation Measurement UHBR10 TP2

SSC Phase Deviation Measurement UHBR13.5 TP2

SSC Phase Deviation Measurement UHBR20 TP2

SSC Slew Rate Measurement

SSC Slew Rate Measurement UHBR10 TP2

SSC Slew Rate Measurement UHBR13.5 TP2

SSC Slew Rate Measurement UHBR20 TP2

Unit Interval Measurement

Unit Interval Measurement UHBR10 TP2

Unit Interval Measurement UHBR13.5 TP2

Unit Interval Measurement UHBR20 TP2

Returns
<String>
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Examples

TEKEXP:LIST? TEST command returns the list of available tests for the selected device.

Query the available version names of the application

This command queries the list of available version names of the application for the selected device as comma separated values.
Syntax

TEKEXP:LIST? VERSION (Query)

Returns

<String>

Examples

TEKEXP:LIST? VERSION command returns the list of version names for the selected device.

Query the list of available instruments based on the specified instrument type
This command queries the list of available instruments based on the specified instrument type.

Syntax

TEKEXP:LIST? INSTRUMENT, "<InstrumentType>" (Query)

Command argument

Argument Name Argument value
<InstrumentType> <String>
Returns

<String>

Examples

TEKEXP:LIST? INSTRUMENT, "Real Time Scope" command returns the list of available instruments based on the real
time scope type.

Set or query the IP address of the instrument based on the specified instrument
type

This command sets or queries the IP address of the instrument based on the specified instrument type.

Syntax

TEKEXP: INSTRUMENT? "<InstrumentType>" (Query)

TEKEXP:INSTRUMENT, "<InstrumentType>","<Value>" (Set)

Command argument

Argument Name Argument Type

<InstrumentType> <String>
Table continued...
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Argument Name Argument Type

<Value> <String>
TCPIP:: XXX XX XXX XXX::INSTR

Returns

<String>

Examples

TEKEXP: INSTRUMENT? "<InstrumentType>" command returns the IP address of the oscilloscope.

TEKEXP: INSTRUMENT, "<InstrumentType>", "<value>" command sets the oscilloscope to the specified IP address.

Query the information of the generated report file

This command queries the information of the generated report file in the format "<FileSize>","<FileName>".
Pre-requisite

A session should be run earlier and the report should be generated to get the information of the report.
Syntax

TEKEXP:INFO? REPORT (Query)

Returns

<FileSize>:; <String>

<FileName>:; <String>

Examples

TEKEXP:INFO? REPORT command returns the information of the generated report in the format ("1215”,"DUT001.mht”).

Query the information of the generated waveform files

This command queries the information of the generated waveform files in the format.

<File1Size,"File1Name”>.

If there are more than one waveform, the waveform file names are displayed with the comma separated values in the format
<File1Size,"File1Name"> <File2Size,"File2Name">.

Syntax

TEKEXP: INFO? WEM (Query)

Returns

<FileSize>:: <String>

<FileName>:: <String>

Examples

TEKEXP: INFO? WFM command returns the information of the generated waveform in the format (20000858,"X:\<Application
Name>\Untitled Session\DUT001120200916_041609\Iter1_Short Record-length for SCOPE Period_NoSSC_DIFF.wfm”).
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Query the information of the generated image files
This command queries the information of the generated image files in the format.
<File1Size,"File1Name”>.

If there are more than one image, the image file names are displayed with the comma separated values in the format
<File1Size,"File1Name"> <File2Size,"File2Name">.

Syntax

TEKEXP: INFO? IMAGE (Query)

Returns

<FileSize>:: <String>

<FileName>:: <String>

Examples

TEKEXP: INFO? IMAGE command returns the information of the generated image

in the format (109058, "X:\<Application Name>\Untitled Session\DUT001\20200916_041609\Iter1_Short
Record-length for SCOPE Period_NoSSC_DIFF.png";22794,"X:\<Application Name>\UntitledSession\DUT001\20
200916_041609\ScopePeriodPlot_lteration1WithCursor.png").

Query the active TekExpress application name

This command queries the active TekExpress application name running on the oscilloscope.
Syntax

TEKEXP: * IDN? (Query)

Returns

<String>

Examples

TEKEXP : * IDN? command returns the active TekExpress application name running on the oscilloscope.

Sets or query the acquire mode status
This command sets or queries the acquire mode status.

Syntax

TEKEXP:ACQUIRE MODE <Mode> (Set)
TEKEXP:ACQUIRE MODE? (Query)

Command arguments

Argument Name Argument value

<Mode> « LIVE
+  PRE-RECORDED
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Returns

LIVE | PRE-RECORDED

Examples

TEKEXP:ACQUIRE MODE LIVE command sets the acquire mode to the Live mode.

TEKEXP:ACQUIRE MODE? command returns the current acquire mode.

Set or query the execution mode status
This command sets or queries the execution mode status.

Syntax

TEKEXP:MODE <Mode> (Set)

TEKEXP : MODE ? (Query)

Command arguments

Argument Name Argument value

<Mode> +  COMPLIANCE
+ USER-DEFINED

Returns
COMPLIANCE | USER-DEFINED
Examples

TEKEXP:MODE COMPLIANCE command sets the execution mode to the compliance mode.

TEKEXP : MODE ? command returns the current execution mode.

Generate the report for the current session

This command generates the report for the current session.
Syntax

TEKEXP:REPORT GENERATE(Set)

Arguments

N/A

Examples

TEKEXP:REPORT GENERATE command generates the report for the current session.

Query the value of specified report header field in the report

This command queries the value of specified report header field in the report.
Syntax

TEKEXP:REPORT? “<Device Field>" (Query)
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Command arguments

Argument Name

Argument Type

<Device Field>

Device field is the header name of each field in the setup
information section of the report.

<String>

Returns
<String>
Examples

TEKEXP:REPORT? "DUT ID" command returns the value of DUT ID field in the report.

Query the value of specified result detail available in report summary/details

table

This command queries the value of specified result detail available in report summary/details table.

Syntax

TEKEXP:RESULT? "<TestName>" (Query)

TEKEXP:RESULT? "<TestName>", "<ColumnName>" (Query)

TEKEXP:RESULT? "<TestName>", "<ColumnName>", <RowNumber> (Query)

Command arguments

Itis the column header name of which the details are required in the
report.

Argument Name Argument Type
<TestName> <String>

It is the test name of which the details are required in the report.

<ColumnName> <String>

<RowNumber>

It is the row number of which the details are required in the report.

<String>

Returns
<String>
Examples

TEKEXP:RESULT? "<TestName>" will return the pass fail status of test.
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TEKEXP:RESULT? "<TestName>", "<ColumnName>" will return all the row values of specific column for the test with
comma separated values.

TEKEXP:RESULT? "<TestName>", "<ColumnName>", <RowNumber> will return the column value of specified row
number.

Restore the setup to default settings
This command restores the setup to default settings.

Syntax

TEKEXP:SETUP Default (Set)

Arguments

N/A

Examples

TEKEXP:SETUP Default command restores the setup to default settings.

Save the settings to a specified session

This command saves the settings to a specified session.
Syntax

TEKEXP:SETUP Save, "<SessionName>"

Command arguments

Argument Name Argument value
<SessionName> <String>
Examples

TEKEXP:SETUP Save, "<SessionName>" command saves the settings to a specified session.

Open the setup from a specified session

This command opens the setup from a specified session.
Syntax
TEKEXP:SETUP Open, "<SessionName>" (Set)

Command arguments

Argument Name Argument value
<SessionName> <String>
Examples

TEKEXP:SETUP Open, "<SessionName>" command opens the setup from a specified session.
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Query the current setup file name
This command queries the current setup file name.
Syntax

TEKEXP:SETUP? CURRENT (Query)

Returns

<String>

Examples

TEKEXP:SETUP? CURRENT command returns the current setup file name.

Run/stop/pause/resume the selected measurements execution in the application

This command run/stop/pause/resume the selected measurements execution in the application.

Syntax

TEKEXP:STATE <operation mode> (Set)

Command arguments

Argument Name Argument value
<operation mode> « RUN

+ STOP

+  PAUSE

+ RESUME

Returns
RUN | STOP | PAUSE | RESUME
Examples

TEKEXP:STATE RUN command runs the execution for the selected measurements.

Query the current measurement execution status
This command queries the current measurement execution status.

Syntax

TEKEXP:STATE? (Query)

Returns

RUNNING | PAUSED | WAIT | ERROR | READY

Examples

TEKEXP : STATE? command returns the current measurement execution status.
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Query whether the current setup is saved or not saved
This command queries whether the current setup is saved or not saved.

Syntax

TEKEXP:STATE? SETUP (Query)

Returns

Saved or Not-Saved

Examples

TEKEXP:STATE? SETUP command returns whether the current setup is saved or not saved.

Query the status of the previous command execution
This command queries whether the previous command execution is completed successfully.
Syntax

TEKEXP: *OPC? (Query)

Returns

{0] 1} or {True | False}

1 or True indicates that command execution is successful.

0 or False indicates that command execution is failed.
Examples

TEKEXP : *OPC? command returns whether the previous command operation is completed successfully.

Query the last error occurred
This command queries the last error occurred.
Syntax

TEKEXP: LASTERROR? (Query)

Returns

<String>

Examples

TEKEXP : LASTERROR? command returns the last error occurred.

Set or query the popup details
This command sets or queries the popup details.

Syntax
TEKEXP : POPUP? (Query)

TEKEXP:POPUP "<PopupResponse>" (Set)
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Command arguments

Argument Name

Argument value

<PopupResponse>

* Yes
* No

Returns

The pop-up details return in the following format:

"<Tittle>","<message>","<response1>,<response2>".

Where,

<Tittle> :: <String>

<message> :: <String>
<response1>,<response2> :: <String>

Examples

TEKEXP : POPUP? command returns the popup details in following format ": "Do you really want to exit TekExpress?";Responses: "Yes,

No".

TEKEXP:POPUP "Yes" command sets the popup response to Yes.

Set or query the View report after generating option status

This command sets or queries the enable/disable status of the View report after generating function.

Syntax

TEKEXP:VALUE? GENERAL, "View Report After Generating" (Query)

TEKEXP:VALUE GENERAL, "View Report After Generating",<value> (Set)

Arguments

Argument Name

Argument value

<Value> {True | False} or {1 0}
It represents enabled or disabled.
Where,
+ Trueor 1-enabled
+ False or 0 - disabled
Returns

{True | False} or {0 | 1}
Examples

TEKEXP:VALUE? GENERAL, "View Report After Generating" command returns the enable or disable status of

view report after generating option.
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TEKEXP:VALUE GENERAL,"View Report After Generating",<value>command enable or disable the view
report after generating option.

Set or query the enable/disable status of Verbose function

This command sets or queries the enable/disable status of Verbose function.
Syntax
TEKEXP:VALUE VERBOSE, "<Value>" (Set)

TEKEXP:VALUE? VERBOSE (Query)

Arguments
Argument Name Argument value
<Value> {True | False} or {1 0}
It represents enabled or disabled.
Where,
+ Trueor 1 - enabled
+ False or 0 - disabled
Returns

{True | False} or {0 | 1}
Examples
TEKEXP:VALUE VERBOSE, "<Value>" command enable or disable the Verbose function.

TEKEXP:VALUE? VERBOSE command returns the enable or disable status of Verbose function.

Set or query the waveform file recalled for the specified test name and acquire
type

This command set or queries the waveform file recalled for the specified test name and acquire type.

If there are more than one waveform, the waveform file names are displayed with the symbol "$" separated values in the format
<WaveformFileName1$ WaveformFileName2>.

Syntax

TEKEXP:VALUE WFMFILE,<TestName>, <AcquireType>,<WaveformFileName> (Set)
TEKEXP:VALUE? WFMFILE, <TestName>, <AquireType> (Query)

Returns

<String>

Examples

TEKEXP:VALUE WFMFILE,<TestName>, <AquireType>, <WaveformFileName> command recalls the sepcified
waveform file for the specified testname and acquire type.
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TEKEXP:VALUE? WEMFILE, <TestName>, <AquireType> command returns the waveform file name recalled for the
specified testname and acquire type.

Sets or query the limit values in the limits editor window

This command sets or queries the limit values in the limits editor window.

Syntax

TEKEXP:VALUE LIMIT,<TestName>,<LimitHeader>,<Valuel>,<CompareString>,<Value2>(Set)
TEKEXP:VALUE? LIMIT,<TestName>,<LimitHeader> (Query)

Returns

<String> or <NRf>

Examples

TEKEXP:VALUE LIMIT,<TestName>,<LimitHeader>,<Valuel>,<CompareString>,<Value2> command
sets the limits value for the specified testhame and limit header.

TEKEXP:VALUE? LIMIT,<TestName>,<LimitHeader> command returns the limits value for the specified testname and
limit header.

Exit or close the application
The command exits or close the application
Syntax

TEKEXP : EXIT(Set)

Examples

TEKEXP:EXIT command close the application.
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Example

import socket

import time

#Create Socket

skt= socket.socket(socket. AF_INET,socket. SOCK_STREAM)
skt.connect(("localhost",5000))

#Measurement for execution

measurement = "Random Jitter (RJ) Measurements UHBR10 TP2"

#Setting the Mode to LIVE
skt.sendall("TEKEXP:ACQUIRE_MODE LIVE\n")

#setting the device

skt.sendall("TEKEXP:SELECT DEVICE,\"DisplayPort\"\n")
time.sleep (2)

skt.sendall("TEKEXP:SELECT? DEVICE\n")

time.sleep (2)

status=str(skt.recv(1024))

print "The selected device is : "+status

# Select the Suite

skt.sendall("TEKEXP:SELECT SUITE \"Transmitter\"\n")
skt.sendall("TEKEXP:SELECT? SUITE\n")

time.sleep (5)

status=str(skt.recv(1024))

print "The selected Suite is : "+status

#GENERAL Parameters SCPI Commands

print "Started setting the GENERAL parameters"
#Set DUT ID

dutid = "DemoDUTID"
skt.sendall("TEKEXP:VALUE DUTID,"+dutid+"\n")
time.sleep(2)

skt.sendall("TEKEXP:VALUE? DUTID\n")
time.sleep (5)

status=str(skt.recv(1024))

print "After setting the DUT Id :"+status

#Exclude UHBR13.5 and UHBR20
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skt.sendall("TEKEXP:VALUE GENERAL,UHBR13.5,\"Excluded\"\n")
time.sleep (2)

skt.sendall("TEKEXP:VALUE GENERAL,UHBR20,\"Excluded\"\n")
time.sleep (2)

skt.sendall( TEKEXP:SELECT GENERAL,SignalPreset_ UHBR10,P0_\n")
time.sleep(5)

skt.sendall(' TEKEXP:SELECT GENERAL,SSC,SSC_Enable\n')
time.sleep(5)

skt.sendall("TEKEXP:VALUE? GENERAL,UHBR10\n")

time.sleep (5)

#Select singlepreset

print "The selected Measurement is : "+measurement
status=str(skt.recv(1024))
print "Unselecting the UHBR135 and UHBR20 datarates :"+status

# Deselect All
skt.sendall( TEKEXP:SELECT TEST,ALL,FALSE'+\n")

# Select Measurement

print "Select Measurement : "+measurement

skt.sendall( TEKEXP:SELECT TEST,'+'Random Jitter (RJ) Measurements UHBR10 TP2,'+'TRUE'+n’)
time.sleep(5)

print "The selected Measurement is : "+measurement

# For de-selecting measurement use - skt.sendall("TEKEXP:SELECT TEST,"+"'measurement"'+"FALSE\n")

#Start running the selected Test

print "Starting Run"
skt.sendall("TEKEXP:STATE RUN\n")
print "Clicked start button."
time.sleep(5)
skt.sendall("TEKEXP:POPUP \"OK\"\n")
time.sleep(10)
skt.sendall("TEKEXP:STATE?\n")
time.sleep(5)

status = str(skt.recv(1024))

print "Hi"

status=status.strip()
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while (status == "RUNNING" or status == "ERROR" or status=="WAIT"):

print "Running..."

skt.sendall("TEKEXP:STATE?\n")

time.sleep(2)

status = str(skt.recv(1024))

status = status.strip()

if status == "ERROR\n" or status=="WAIT\n":
skt.sendall("TEKEXP:POPUP?\n")

status = str(skt.recv(1024))

print status

popupResponse = raw_input("Enter popup response:")
skt.sendall("TEKEXP:POPUP "+"\""+popupResponse+"\""+"\n")
status = str(skt.recv(1024))

print "Measurement execution completed."
#Transfer the reports

print "Getting the info of Report file..."
skt.sendall("TEKEXP:INFO? REPORT\n")
status = str(skt.recv(1024))

print "ReportFile Info: "+status

filelnfo= status.split(',")

fileLength = long(fileInfo[0])

destinationPath = "C:\\"

print "Exporting report file to client location "+destinationPath+" ...
skt.sendall("TEKEXP:EXPORT REPORT\n")

while(len(status) < fileLength):
received = skt.recv(fileLength)

status = status + received

fileName = fileInfo[1].strip()

fileName = fileName.strip(\")
time.sleep(15)

f= open(destinationPath+fileName,'wb")
f.write(status)

f.close()

print "Export completed for "+fileName
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#Saving Session

sessionName = 'PI_Session1'

skt.sendall("TEKEXP:SETUP SAVE,"+sessionName+"\n")
time.sleep (3)

print "Querying the result of ..."

skt.sendall("TEKEXP:RESULT? \"Test 3.1_Eye diagram testing\"\n")
time.sleep(5)

status = str(skt.recv(1024))

status=status.strip()

print "The result of"+measurement+"is"+status

skt.close()
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Application directories

You can find the application files at C:\Program Files\Tektronix\<Application Name>. The application directory and associated files are
organized as follows:

v My TekExpress
DisplayPort
v DisplayPort 2.0
v 1Lane_UHBR10 TP2 TP3_EQ
hd DUTOO1
20201211_025419
20201211_030432
20201211_031250
20201211_033324

The following table lists the default directory names and their usage:

Table 18: Application directories and usage

Directory names Usage

Bin Contains application libraries

Compliance Suites Contains test suite specific files

Examples Contains various support files

ICP Contains instrument and application specific interface libraries
Images Contains images of the application

Lib Contains utility files specific to the application

Licenses Contains all the license files

Report Generator Contains style sheets for report generation

Tools Contains instrument and application specific files
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File name extensions

The TekExpress <Application Name> software uses the following file name extensions:

Table 19: File name extension

File name extension Description
* TekX Application session files (the extensions may not be displayed)
*.py Python sequence file.
~xml Test-specific configuration information (encrypted) files.
Application log files
osv Test result reports
Plot data
".mht Test result reports (default)
Test reports can also be saved in HTML format
".pdf Test result reports
Application help document
* xslt Style sheet used to generate reports
*.png Captured images

View test-related files

Files related to tests are stored in My Documents\<Application Name>\Untitled session folder. Each test setup in this folder has both a test

setup file and a test setup folder, both with the test setup name. The test setup file is preceded by the TekExpress icon.

Inside the test setup folder is another folder named for the DUT ID used in the test sessions. The default is DUT001.

Inside the DUT001 folder are the session folders and files. Each session also has a folder and file pair, both named for the test session

using the naming convention (date)_(time). Each session file is stored outside its matching session folder:

[[5)20110520_154553
C)20110520_154713
C)20110520_155111
C)20110520_155920
C)20110520_160103
Vi 20110520_154553
Vi 20110520_154713
Vi 20110520_155111
Vi 20110520_155920
Vi 20110520_160103

Each session folder contains image files of any plots generated from running the test session. If you selected to save all waveforms or ran
tests using prerecorded waveform files, these are included here.
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The first time you run a new, unsaved session, the session files are stored in the Untitled Session folder located at X: \<Application Name>.
When you name and save the session, the files are placed in a folder with the name that you specify. A copy of the test files stay in the
Untitled Session folder until you run a new test or until you close the application.

Deskew channels

If skew is present between positive and negative channels, then the channels need to be deskewed before being used for waveform
measurements. TekExpress DisplayPort 2.0 solution provides support for channel deskew using the following method:

N o o~ oobd =

8.
9.

Determine what the skew is for each channel.

From the TekScope menu, click Vertical and select Deskew.

In the Deskew/Attenuation window, click the channel (1 — 4) button for the first channel to be deskewed.

Click in the Ch(x) Deskew Time entry field and enter the skew. The skew can be +ve or -ve.

Click the channel button for the next channel and repeat step 4, above.

After entering the skew for all the channels that require it, from the Options menu in TekExpress DisplayPort 2.0, select Deskew.

In the Deskew dialog box, select the desired level:

+ Less than 100 mV signal amplitude: Select this if the signal amplitude is such that the oscilloscope’s vertical setting is less than
100 mV/division.

+ 100 mV or greater signal amplitude: Select this if the signal amplitude is such that the oscilloscope’s vertical setting is greater than
100 mV/division.

Click Read Deskew/Attn.
When finished, click Close.

Each input channel has its own deskew settings. Deskew compensates individual channels for probes or cables of different lengths. The
instrument applies the delay values after each completed acquisition. The deskew values are saved as part of the instrument setup. The
deskew values for the selected channel are retained until you change the probe, you restore a saved setup, or you recall the factory setup.

See Also

Pre-Run checklist
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Appendix-A

Following are the compliance parameters for all DisplayPort 2.0 measurements

Table 20: Compliance Parameters list for all DisplayPort 2.0 measurements

Test Name Data Rate Preset Voltage Swing SSC Test Point
Eye Diagram Testing |, ypgR10 .« PO 800 mv . SSCEnabled [+ TP2
Data Dependent + UHBR13.5 .+ PO1 + SSCDisabled |+ TP3_EQ
Jitter (DD.) UHBR20 . P02 + Both
Measurement
Random Jitter (RJ) " PO
Measurement P04
Total Jitter (TJ) ©OPOS
Measurement + P06
Uncorrelated Jitter .+ PO7
(UJ) Measurement .« P08
Uncorrelated + P09
Deterministic Jitter « P10
(UDJ) Measurement ¢ P11
+ P12
+ P13
+ P14
+ P15
Low Frequency «  UHBR10 . PO 800 mV +  SSC Enabled TP2
nggmﬁi Jiter UHBR13.5 . PO1 . SSC Disabled
(LFUDJ) + UHBR20 « P02 + Both
Measurement « P03
Unit Interval + P04
Measurement « P05
+ P06
+ P07
+ P08
+ P09
+ P10
+ P11
+ P12
+ P13
+ P14
+ P15

Table continued...
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Test Name

Data Rate

Preset

Voltage Swing

SSC

Test Point

SSC Down Spread
Rate Measurement

Measurement

SSC Phase Deviation |,

SSC Slew Rate
Measurement

+ UHBR10
UHBR13.5
UHBR20

PO
PO1
P02
. P03
. P04
. P05
. P06
. P07
. P08
. P09
.+ P10
- PN
. P12
- P13
. P14
.+ P15

800 mV

SSC Enabled

TP2

TekExpress® DisplayPort 2.0 Automated Solution

91



Index

A

About SCPI command 54
Acquisitions
selecting 35
Activate the license
license 13
Advanced View 31
Application directories 87

C

Channel deskew 89
Comments
adding to reports 30
Compliance Mode 15
Compliance View 15, 31
Connected instruments
searching for 27
Connection requirements 16
Contacting Tektronix 11
Conventions 10
CTS version 31

D

Deselect All (tests) 34
Deskewing channels 89

Downloading and installing the software

Download the software
Install the software 13
DUT Automation 32
DUTID 30
DUT settings 30

E

Email notification and setup 26
Equipment setup 16
Example 83

F

File name extensions 88
Filter the test results 47

G

Getting help and support 70
Getting started 12
GPIB 27

H

Hardware requirements
Hardware 12

Icons used
symbols 10
Instruments
discovering connected 27

K

Key features 9

L

LAN 27

Lane source 35

Lanes 35

Launch the application 22

license key 14

Live waveforms 38

load the saved test setup
load the test setup 52

Log view 45

Log View 44

M

My TekExpress folder 18

N
Non-VISA 27

0]

Options menu
Instrument control settings 27
Options menu functions 25

Oscilloscopes supported 12

P

Panels
Setup 29
Pre-recorded Mode 20

Pre-recorded waveform files 20, 36

Pre-run checklist 18



Preferences menu 47
Preferences tab
Preferences 42
Probe configuration 35
Product documents
TekExpress Application documents 10

R

recalling test setup 52
References 87
Remote commands 54
report generation 48
report generation options 48
report generation settings
Configure report generation settings 48
Reports
receiving in email notifications 26
Reports panel 48
Results panel 47

S

Save the configured test setup
Save the test setup 52
Save the test setup 53
Save the test setup with a different name 53
Saving test setup 52
Schematic button 34
SCPI command 54
SCPI Commands
SCPI 54
Select a loaded test setup 52
Select a pre-run session loaded test setup 52
Select Al (tests) 34
Setting up the test environment
test environment 15
Setup Panel 29
Signal Path Compensation (SPC) 20
Socket configuration for SCPI commands
Socket configuration 54
Software requirements
Softwares 13
software version 14
Start the application 22
Status panel 44
Support 11
System requirements 12

T

Technical support 11
Tek Link 27
TEKEXP:*IDN? 74
TEKEXP:*OPC? 79

TEKEXP:ACQUIRE_MODE LIVE 74
TEKEXP:ACQUIRE_MODE? 74

TEKEXP:EXIT 82

TEKEXP:INFO? IMAGE 74

TEKEXP:INFO? REPORT 73

TEKEXP:INFO? WFM 73

TEKEXP:INSTRUMENT, "<InstrumentType>","<value>" 72
TEKEXP:INSTRUMENT? "<InstrumentType>" 72
TEKEXP:LASTERROR? 79

TEKEXP:LIST? DEVICE 69

TEKEXP:LIST? INSTRUMENT,"<Real Time Scope>" 72
TEKEXP:LIST? SUITE 69

TEKEXP:LIST? TEST 70

TEKEXP:LIST? VERSION 72

TEKEXP:MODE COMPLIANCE 75

TEKEXP:MODE? 75

TEKEXP:POPUP "Yes" 79

TEKEXP:POPUP? 79

TEKEXP:REPORT GENERATE 75

TEKEXP:REPORT? "<Device Field>" 75

TEKEXP:RESULT? "<TestName>" 76

TEKEXP:RESULT? "<TestName>","<ColumnName>" 76
TEKEXP:RESULT? "<TestName>","<ColumnName>",<RowNumber>
76

TEKEXP:SELECT DEVICE,"DeviceName" 60
TEKEXP:SELECT SUITE,"<SuiteName>" 61

TEKEXP:SELECT TEST,"<ALL>" 61

TEKEXP:SELECT TEST,"<TestName>",1 61

TEKEXP:SELECT VERSION,"<VersionName>" 62
TEKEXP:SELECT? DEVICE 60

TEKEXP:SELECT? SUITE 61

TEKEXP:SELECT? TEST 61

TEKEXP:SELECT? VERSION 62

TEKEXP:SETUP Default 77

TEKEXP:SETUP Open,"<SessionName>" 77

TEKEXP:SETUP Save,"<SessionName>" 77

TEKEXP:SETUP? CURRENT 78

TEKEXP:STATE RUN 78

TEKEXP:STATE? 78

TEKEXP:STATE? SETUP 79

TEKEXP:VALUE

ACQUIRE, <TestName>","<Acquire Type>","<ParameterName>","<Para
meterValue>" 68

TEKEXP:VALUE
ANALYZE,"<TestName>","<ParameterName>","<ParameterValue>" 68
TEKEXP:VALUE DUTID,"Value" 60

TEKEXP:VALUE GENERAL,"<ParameterName>","<Value>" 63
TEKEXP:VALUE GENERAL,"View Report After Generating”,<value>
80

TEKEXP:VALUE

LIMIT,<TestName> <LimitHeader>,<Value1>,<CompareString>,<Value
2> 82

TEKEXP:VALUE VERBOSE,"<Value>" 81

TEKEXP:VALUE

WFMFILE,<TestName>,<Aquire Type>,<WaveformFileName> 81



TEKEXP:VALUE?
ACQUIRE, <TestName>">","<Acquire Type>","<ParameterName>" 68
TEKEXP:VALUE? ANALYZE,"<TestName>" "<ParameterName>" 68
TEKEXP:VALUE? DUTID 60
TEKEXP:VALUE? GENERAL,"<ParameterName>" 63
TEKEXP:VALUE? GENERAL,"View Report After Generating" 80
TEKEXP:VALUE? LIMIT,<TestName>,<LimitHeader> 82
TEKEXP:VALUE? VERBOSE 81
TEKEXP:VALUE? WFMFILE,<TestName>,<Aquire Type> 81
test execution status 44
Test Lanes 32
Test results
send by email 26
test run preferences 42
Test selection controls 34
Test setup files overview
Test setup files 52
Test Status 44
Tests
running 18
running prerecorded 20
selecting 34
setting up 15

U

Untitled Session folder 18

'

View a report 51

View option 31

View summary of test results
summary of test results 47

View test execution logs 45

View the test execution status 44

W

Waveform files

using pre-recorded 36
Waveforms

acquiring live 38



	Table of Contents
	Contact and Copyright
	Welcome
	Key features

	Getting help and support
	Product documents
	Conventions
	Technical support

	Getting started
	Hardware requirements
	Compatibility
	Minimum system requirements
	Supported probes

	Software requirements
	Downloading and installing the software
	Activate the license
	View software version and license key details


	Setting up the test environment
	About setting up tests
	Equipment connection setup
	Individual test configuration
	About running tests
	Before you click start
	Pre-Run checklist
	Run a test in pre-recorded mode

	Starting the application
	Application controls
	Options menu functions
	Configure email settings
	TekExpress instrument control settings


	Setup panel: Configure the test setup
	DUT: Set DUT settings
	Test Selection: Select the tests
	Acquisitions: Set waveform acquisition settings
	Set acquisition tab parameters
	Use pre-recorded waveforms for analysis
	Running measurements using pre-recorded waveforms
	Acquire live waveforms for analysis

	Configuration: Set measurement limits for tests
	Preferences: Set the test run preferences

	Status panel: View the test execution status
	View test execution status
	View test execution logs

	Results panel: View summary of test results
	Filter the test results

	Reports panel: Configure report generation settings
	Select report generation options
	View a generated report

	Saving and recalling test setup
	Test setup files overview
	Save the configured test setup
	Load a saved test setup
	Select a pre-run session from the loaded test setup
	Save the test setup with a different name

	SCPI Commands
	About SCPI command
	Socket configuration for SCPI commands
	Set or query the device name of application
	Set or query the DUTID of application
	Set or query the suite name of the application
	Set or query the test name of the application
	Set or query the version name of the application
	Set or query the general parameter values
	Set or query the acquire parameter values
	Set or query the analyze parameter values
	Query the available devices in the DUT panel of the application
	Query the available suites for the selected device
	Query the list of available tests of the application
	Query the available version names of the application
	Query the list of available instruments based on the specified instrument type
	Set or query the IP address of the instrument based on the specified instrument type
	Query the information of the generated report file
	Query the information of the generated waveform files
	Query the information of the generated image files
	Query the active TekExpress application name
	Sets or query the acquire mode status
	Set or query the execution mode status
	Generate the report for the current session
	Query the value of specified report header field in the report
	Query the value of specified result detail available in report summary/details table
	Restore the setup to default settings
	Save the settings to a specified session
	Open the setup from a specified session
	Query the current setup file name
	Run/stop/pause/resume the selected measurements execution in the application
	Query the current measurement execution status
	Query whether the current setup is saved or not saved
	Query the status of the previous command execution
	Query the last error occurred
	Set or query the popup details
	Set or query the View report after generating option status
	Set or query the enable/disable status of Verbose function
	Set or query the waveform file recalled for the specified test name and acquire type
	Sets or query the limit values in the limits editor window
	Exit or close the application
	Example

	References
	Application directories
	File name extensions
	View test-related files
	Deskew channels
	Appendix-A

	Index
	A
	C
	D
	E
	F
	G
	H
	I
	K
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W


